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Recommended Reading 
 
See the latest versions of the following: 

• Base SAS Procedures Guide.   

• DataFlux Authentication Server: Administrator’s Guide, 

• DataFlux Data Management Server: Administrator's Guide 

• DataFlux Data Management Server User's Guide 

• DataFlux Data Management Studio: Installation and Configuration Guide. 

• DataFlux Data Management Studio Online Help 

• DataFlux Data Management Studio: User's Guide 

• DataFlux Federation Server: Administrator's Guide 

• DataFlux Secure: Administrator's Guide 

• DataFlux Web Studio: Installation and Configuration Guide 

• DataFlux Web Studio Server: User's Guide 

• SAS 9.4 Intelligence Platform: System Administration Guide 

• SAS Data Integration Studio: User's Guide. 

• SAS Federation Server: Administrator's Guide 

• SAS Federation Server Manager: User's Guide 

• SAS Visual Process Orchestration Server: Administrator's Guide 

• SAS Visual Process Orchestration: User's Guide 

 

 

For a complete list of SAS publications, go to support.sas.com/bookstore. If you have questions about 
which titles you need, please contact a SAS Publishing Sales Representative:  
 
SAS Publishing Sales 
SAS Campus Drive 
Cary, NC 27513-2414 
Telephone: 1-800-727-3228 
Fax: 1-919-677-8166 
Email: sasbook@sas.com 
Web address: support.sas.com/bookstore 

 

mailto:sasbook@sas.com
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Chapter 1: Overview of the 
Migration Guide 
 

This document includes two primary sections: 

• General Information About Migration 

• Specific Migration Scenarios 
 

The section called General Information about Migration provides overall information that you 
need to consider when migrating from one DataFlux product to another. You should read 
and review this section if you are considering migrating from DataFlux dfPower Studio and 
DataFlux Data Integration Server to the DataFlux Data Management Studio and DataFlux 
Data Management Server. 

The section called Specific Migration Scenarios provides step-by-step guidance when 
migrating from DataFlux dfPower Studio and DataFlux Data Integration Server v. 8.x to 
DataFlux Data Management Studio or Server. 

The Specific Migration Scenarios section is intended for users who have read the General 
Information section or for those who have a good understanding of what is needed and 
simply need some guidance on stepping through the migration steps. In the Specific 
Migration Scenario section, each sub-section builds on the previous section. Therefore, if 
you start the migrating Architect jobs section without completing the Repository migration 
section, you will have problems with the migration steps. 

• Migrating from DataFlux dfPower Studio 8.1/8.2 to DataFlux Data Management Studio 

• Migrating from DataFlux Integration Server 8.1/8.2 to DataFlux Data Management 
Server 

• Migrating from DataFlux Data Management Studio 2.1 to DataFlux Data Management 
Studio 2.2 or Later 

• Migrating from DataFlux Data Management Server 2.1 to DataFlux Data Management 
Server 2.2 or Later 
 



 
DataFlux Migration Guide 3 
 

 

 

DataFlux Data Management Studio 2.3 and later versions: 

This document was originally written for migration to DataFlux Data Management 2.2 release. If 
you are starting from a later release, use the “2.1 to 2.2 or Later” sections. Although all examples 
and screenshots show version 2.2, the same ideas apply to version 2.3 and later as well. Special 
considerations for versions 2.3 and later are called out in boxes like this. 
 
Starting with the 2.3 version, later releases can be installed in the same location as the previous 
version. If DataFlux Data Management Studio 2.3 was installed into C:\DataFlux\DMStudio\studio1, 
then any later release can be installed into the same location. It is highly recommended to do this 
as it minimizes the migration process greatly. If your installation uses the SAS Deployment Wizard, 
this happens automatically. Configurations from the previous install are kept.  
 
SAS 9.3 customers can upgrade to DataFlux Data Management 2.4. Since SAS 9.4 included 
DataFlux Data Management Studio 2.4 and DataFlux Data Management Server 2.4, those 
customers can upgrade to version 2.5 and later. 
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Chapter 2: General Information 
about Migration 
Overview of the DataFlux Software 
This guide describes how to migrate your content from DataFlux dfPower Studio to DataFlux 
Data Management Studio. The following diagram illustrates the components of the software 
when used with DataFlux Federation Server. Note that if you are using the SAS Federation 
Server, that portion of the diagram would be different. 
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DataFlux Data Management Studio 
DataFlux Data Management Studio is part of a data management suite that combines data 
quality, data integration, and master data management. Compared to DataFlux dfPower 
Studio, DataFlux Data Management Studio has a more integrated interface, better 
management of data flows and process flows, enhanced data access through the DataFlux 
Federation Server or the SAS Federation Server, and many other new features. The section 
that discusses migrating from DataFlux dfPower Studio describes how to migrate your 
content and manage the impact of differences between DataFlux Data Management Studio 
and DataFlux dfPower Studio. 

Repositories 
When you create jobs and other objects in DataFlux Data Management Studio, they are 
stored in repositories that are similar to DataFlux dfPower Studio repositories. Profiles, 
rules, tasks, and some other objects in a repository are stored in database format. You can 
specify a separate storage location for objects that are stored as files, such as data jobs, 
process jobs, and queries. You can create a private repository for your own use, or you can 
create a shared repository that a number of people can use. The Migrating Repositories 
section describes how to migrate a DataFlux dfPower Studio repository to a DataFlux Data 
Management Studio repository. 

Servers 
DataFlux Data Management Studio can be used by itself or in combination with one or more 
of the following DataFlux servers: 

• The DataFlux Data Management Server, formerly known as the DataFlux Data 
Integration Server, provides a scalable server environment for large DataFlux Data 
Management Studio jobs. Jobs can be uploaded from DataFlux Data Management 
Studio to a DataFlux Data Management Server, where the jobs are executed. 

• The DataFlux Federation Server provides central management of the data connections 
using ODBC or native drivers as well as access privileges for these connections. 

• The DataFlux Authentication Server centralizes the management of users, groups, and 
database credentials. 

The DataFlux Federation Server and DataFlux Authentication Server typically have little 
impact on migration from DataFlux dfPower Studio because both were new to the DataFlux 
Data Management Studio. They could have an impact after migration if you decide to use 
the features these servers provide. 

 

 
DataFlux Data Management 2.7 and later versions: 

In the DataFlux Data Management 2.7 release, DataFlux Data Management Studio, DataFlux Data 
Management Server, and SAS Federation Server now use the SAS Metadata Server for user 
authentication. This means that DataFlux Authentication users need to be ported to the SAS 
Metadata Server and user information in the DataFlux Data Management Server and SAS 
Federation Server needs to be updated to use the new SAS Metadata Server user IDs. This is all 
covered in the Update Security Files after Exporting Users and Groups section. 
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What is Migration? 
For DataFlux dfPower customers, migration is the process in which DataFlux dfPower Studio 
content is upgraded to run in DataFlux Data Management Studio, or DataFlux Data 
Integration Server content is upgraded to run on a DataFlux Data Management Server. 

For those users already on DataFlux Data Management Studio or Server, migration is the 
process by which the latest release of software can be installed in a new environment 
sourced from an older environment running that is running with compatible software 
versions. 

What Versions Can Be Migrated? 
These versions can be migrated: 

Migrate From Migrate To 
DataFlux dfPower Studio 8.x  DataFlux Data Management Studio 2.2 

and later 
DataFlux Data Integration Server 8.x DataFlux Data Management Server 2.2 

and later 
DataFlux Data Management Studio/Server 2.1 DataFlux Data Management Studio/Server 

2.1 and later 
DataFlux Data Management Studio/Server 2.2 DataFlux Data Management Studio/Server 

2.2 and later 
DataFlux Data Management Studio/Server  2.3 DataFlux Data Management Studio/Server 

2.3 and later 
DataFlux Data Management Studio/Server 2.4 DataFlux Data Management Studio/Server 

2.4 and later 
DataFlux Data Management Studio/Server 2.5 DataFlux Data Management Studio/Server 

2.5 and later 
DataFlux Data Management Studio/Server  2.6 DataFlux Data Management Studio/Server 

2.6 and later 
DataFlux Data Management Studio/Server 2.7 DataFlux Data Management Studio/Server 

2.7 and later 
Migration Versions Available 

Note: Migrations from version 8.1 to version 2.1 are supported regardless of 
fix patch level. 
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Summary of the Migration Process 
A typical approach includes: 

• Migrate DataFlux dfPower Studio repository 

• Migrate Architect jobs 

• Migrate Profile jobs 

• Make required post-migration adjustments 

 

For additional information, refer to one of these sections: 

• Migrating from DataFlux dfPower Studio 8.1/8.2 to DataFlux Data Management Studio 

• Migrating from DataFlux Integration Server 8.1/8.2 to DataFlux Data Management 
Server 

• Migrating from DataFlux Data Management Studio 2.1 to DataFlux Data Management 
Studio 2.2 or Later 

• Migrating from DataFlux Data Management Server 2.1 to DataFlux Data Management 
Server 2.2 or Later 
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Chapter 3: Planning the Content 
Migration 
Before migrating, it is important to know what types of jobs, rules, macros, and  content 
can be migrated and if it can be done automatically or if it must be modified and re-created. 

Content That Can Be Automatically Migrated 
The following content can be automatically migrated from DataFlux dfPower Studio to 
DataFlux Data Management Studio. Some migrated items require manual updates before 
you can use them in DataFlux Data Management Studio. 

Repositories 

The Add Repository dialog box in DataFlux Data Management Studio can do an in-place 
migration of a DataFlux dfPower Studio repository. For more information, see Repositories 
and Management Resources. 

Architect Jobs 

You use the upgrade job utilities in DataFlux Data Management Studio to convert DataFlux 
dfPower Studio Architect jobs to process jobs or data jobs. For more information, see 
Architect Jobs. 

Profile Jobs 

You can use the Import Profile Jobs and Link Reports wizard in DataFlux Data Management 
Studio to convert DataFlux dfPower Studio profile jobs. For more information, see Profile 
Jobs. 

Profile Reports That Are Stored in a Repository 

You can use the Import Profile Jobs and Link Reports wizard in DataFlux Data Management 
Studio to link a DataFlux dfPower Studio profile job with a related report and combine the 
two in a DataFlux Data Management Studio profile. For more information, see Profile Jobs. 

Business Rules, Custom Metrics, and Other Items in the Business Rules Manager 

These items are migrated only when their repository is migrated. You cannot migrate 
individual rules, custom metrics, and other items in the Business Rules Manager. For more 
information, see Business Rules, Tasks, and Related Items. 

Queries 

Saved queries that were created with the Query Builder are migrated only when their 
repository is migrated. You cannot migrate individual queries. 
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Content That Must Be Modified or Re-created 
The following content cannot be automatically migrated from DataFlux dfPower Studio to 
DataFlux Data Management Studio. You must modify or re-create the content. 

Repositories and Management Resources (some configurations) 

Differences in metadata architecture and other changes might require you to make manual 
adjustments before or after you migrate DataFlux dfPower Studio repositories and 
Management Resources to DataFlux Data Management Studio. For more information, see 
Changes to Repositories and Management Resources. 

Architect Jobs That Include Certain Nodes 

Architect jobs that include certain nodes require special handling. See Post-Migration Tasks 
for Architect Jobs. 

Profile Reports That Are Stored in a File (.pfo file) 

You cannot convert DataFlux dfPower Studio profile reports that are stored as files (.pfo 
files). For more information, see Changes to Profile Jobs. 

Redundant Data Analysis Reports 

The way that Redundant Data Analysis is calculated has changed. Accordingly, after a 
Redundant Data Analysis profile job is converted, you must re-run the profile in DataFlux 
Data Management Studio to re-create the report. For more information, see Changes to 
Profile Jobs. 

Batch Scripts 

The DataFlux software has a new command line interface, so you must modify any batch 
scripts that execute profexec.exe (Profile command line interface for DataFlux dfPower 
Studio); archbatch.exe (Architect command line interface for DataFlux dfPower Studio), or 
dfexec.exe (command line interface for DataFlux Data Integration Server). For more 
information, see Running Jobs from the Command Line in the Data Jobs section of the 
DataFlux Data Management Studio online Help. 

Configuration Files and Global Options 

You cannot convert configuration files or global options that were created in DataFlux 
dfPower Studio. To review the global options for DataFlux Data Management Studio from 
the main menu, select Tools > Data Management Studio Options. Some options can be 
set with check boxes and similar controls. Other options must be set in configuration files. 
To review or change the settings in DataFlux Data Management Studio configuration files, 
see the Using Configuration Files topic in the Global Options section of the DataFlux 
Data Management Studio online Help. 
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Data Explorations 

You cannot convert Explorations that were created in DataFlux dfPower Studio. You must re-
create them in DataFlux Data Management Studio. See the Data Explorations section in 
the latest version of DataFlux Data Management Studio online Help. Currently, the 
migration software moves DataFlux dfPower Studio Data Explorations into the Folders tree 
in DataFlux Data Management Studio. You cannot use these items in DataFlux Data 
Management Studio, however, so you can select and delete them from the Folders tree. 

DataFlux Data Management Server 

The DataFlux Data Management Studio is a new version of the DataFlux Data Integration 
Server. The move to the new server impacts migration. For more information, see Changes 
Related to the DataFlux Data Management Server. 

Macro Variables 

You might have to make some updates in order for DataFlux dfPower Studio macro 
variables to work in DataFlux Data Management Studio. For more information, see Macro 
Variables. 

SAS Connections 

You cannot convert SAS connections that were created in DataFlux dfPower Studio. You 
must re-create them in DataFlux Data Management Studio. See the Adding SAS Data Set 
Connections section in the latest version of the DataFlux Data Management Studio online 
Help. 
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Repositories and Management Resources 
This section discusses migration scenarios and how to make changes to your repository and 
management resources. Follow the migration instructions for your scenario and then go to 
Changes to Repositories and Management Resources. 

Plan the Migration of Each Repository and Management 
Resource 
Review the following links to anticipate the main issues that might affect the conversion: 

• General Planning for Repositories 

• Migration Scenario: One dfPower Repository, One Management Resource 

• Migration Scenario: One dfPower Repository, Multiple Management Resources 

• Migration Scenario: Multiple dfPower Repositories, One Management Resource 

• Migration Scenario: No dfPower Repository, One or More Management Resources 
 

General Planning for Repositories 

Review the introduction to Specific Migration Scenarios so that you can anticipate the main 
items that you need to update, replace, move, or delete in DataFlux Data Management 
Studio. 

Note: DataFlux Data Management Studio does an in-place migration of a 
DataFlux dfPower Studio repository. DataFlux dfPower Studio cannot access a 
repository that has been converted to DataFlux Data Management Studio 
format. 

Accordingly, make a copy of the dfPower repository to be migrated, and then migrate the 
copy rather than the original. Migrating a copy of your repository enables you to preserve 
your original dfPower content. 

If the dfPower repository is stored on a database server, use DBMS tools to copy the 
repository. Then, create a new ODBC connection that points to the copy. Later, you use that 
new connection to specify the dfPower repository to be migrated. 

If the dfPower repository is stored as a database file (RPS file) on the file system, create a 
new, empty folder structure, such as the one shown in the next display. 

 

In the previous display, dfMigrate is a top-level folder. The Repository subfolder is where 
the dfPower repository file is copied and later converted to a DataFlux Data Management 
Studio repository. The names of these folders are simply examples. 
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The File_Storage subfolder corresponds to the file storage area in a DataFlux Data 
Management Studio repository. Under the folder for the file storage area, you should at 
least create the standard folders for deployable jobs, as described in Changes Related to the 
DataFlux Data Management Server. These standard folder names are not examples. They 
must literally be batch_jobs, data_services, and process_services, as shown in the next 
display. 

 

Note: The standard folders for deployable jobs are not added automatically 
when you migrate a dfPower repository. Accordingly, you must manually 
create the standard job folders in the migrated repository, if you ever deploy 
DataFlux Data Management Studio jobs to a DataFlux Data Management 
Server. 

In this migration guide, the folders in the previous display are used as follows: 

• Unconverted Architect jobs are copied to the Architect_jobs_before folder 

• Architect jobs that have been converted to DataFlux Data Management Studio format 
are saved to a number of different folders. The Architect_jobs_after folder is one 
example. 

• The standard folders for deployable jobs (batch_jobs, data_services, and 
process_services) are mainly intended for DataFlux Data Management Studio jobs 
that are deployed to a DataFlux Data Management Server. 

The Accelerators folder is used for jobs that are associated with DataFlux Accelerators. This 
guide does not cover the migration of accelerators. 
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Migration Scenario: One dfPower Repository, One Management 
Resource 

The next figure illustrates the easiest metadata configuration to migrate one dfPower 
repository and one Management Resource. Assume that Management Resource 1 contains 
Architect jobs and profiles that refer to rules and tasks in Repository A only. 

 

To migrate this configuration, perform the following steps: 

1. Run the New Repository Definition wizard in DataFlux Data Management Studio. 

2. Specify a data location. This would be the physical path to a copy of Repository A.  

3. Specify an empty file storage area, such as the File_Storage folder that is described 
in General Planning for Repositories.  

4. Copy the Architect jobs from Management Resource 1 to that file storage area.  
 
The end result would be a repository where the rules and tasks that are required by 
the jobs are in the same repository, as shown in the following figure: 
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Migration Scenario: One dfPower Repository, Multiple Management 
Resources 

In DataFlux dfPower Studio, it is possible for multiple management resources to contain 
Architect jobs and profiles that refer to rules and tasks in a single repository, as shown in 
the next figure. Assume that both Management Resource 1 and Management Resource 2 
contain Architect jobs and profiles that refer to rules and tasks in Repository A only. 

 

In DataFlux Data Management Studio, however, each repository can have at most one data 
storage area and one file storage area. You cannot create a DataFlux Data Management 
Studio repository that has two file storage areas that correspond to Management Resources 
1 and 2. Given a DataFlux dfPower Studio configuration similar to the one shown above, you 
must perform additional tasks so that all related items can be stored in the same DataFlux 
Data Management Studio repository. 

To migrate this configuration, perform the following steps: 

1. Run the New Repository Definition wizard in DataFlux Data Management Studio.  

2. Specify a data location. This would be the physical path to a copy of Repository A.  

3. Specify an empty file storage area, such as the File_Storage folder that is described 
in General Planning for Repositories.  

4. Copy the Architect jobs from Management Resource 1 and Management Resource 2 
to that file storage area.  
 
The end result would be a repository where the rules and tasks that are required by 
the jobs are in the same repository.  
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Migration Scenario: Multiple dfPower Repositories, One Management 
Resource 

In DataFlux dfPower Studio, it is possible for Architect jobs and profiles in one Management 
Resource to refer to rules and tasks in multiple repositories, as shown here. 

 

In DataFlux Data Management Studio, however, each repository can have at most one data 
storage area and one file storage area. You cannot create a DataFlux Data Management 
Studio repository that has two data storage areas that correspond to Repositories A and B. 
Given a dfPower configuration similar to the one shown above, you must perform additional 
tasks so that all related items can be stored in the same DataFlux Data Management Studio 
repository. For example, you could perform the following steps. 

1. Migrate one dfPower repository as described in Migration Scenario: One dfPower 
Repository, One Management Resource. In the current example, you could migrate 
Repository A. You would specify an empty file storage area for this repository, as 
described in General Planning for Repositories. 

2. Copy the relevant Architect jobs from Management Resource 1 to the file storage area 
for Repository A. 

3. Migrate the other repository or repositories that have rules or tasks that are 
consumed by the jobs in the repository that you migrated in Step 1. In the current 
example, you would migrate Repository B. 

4. In DataFlux Data Management Studio, open the repository that you migrated in Step 
3, such as Repository B. 

5. Use the Business Rule Manager to export the relevant rules or tasks from the 
repository. For the current example, you would export Task bb from Repository B. For 
more information about this step, see the Exporting and Importing Business 
Rules topic in the most current User’s Guide for DataFlux Data Management Studio. 

6. Open the repository that you migrated in Step 1, such as Repository A. 

7. Use the Business Rule Manager to import the rules or tasks that you exported in Step 
5, such as Task bb. For more information about this step, see the Exporting and 
Importing Business Rules topic in the most current User’s Guide for DataFlux Data 
Management Studio. 

http://support.sas.com/documentation/onlinedoc/dfdmstudio/index.html
http://support.sas.com/documentation/onlinedoc/dfdmstudio/index.html
http://support.sas.com/documentation/onlinedoc/dfdmstudio/index.html
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Migration Scenario: No dfPower Repository, One or More 
Management Resources 

In DataFlux dfPower Studio, it is possible for one or more Management Resources to contain 
Architect jobs and profiles that do not refer to rules or tasks in any dfPower repository, as 
shown in the next figure. 

 

In DataFlux Data Management Studio, however, each repository must have one data 
storage area. You cannot create a DataFlux Data Management Studio repository that has a 
file storage area only. 

To migrate this configuration, you would create a new DataFlux Data Management Studio 
repository with a new (empty) data storage area, such as the Repository folder that is 
described in General Planning for Repositories. You would specify an empty file storage area 
as well, such as the File_Storage folder that is described in General Planning for 
Repositories. Then you would copy the relevant Architect jobs to that file storage area. The 
end result would be a repository where the jobs from one or more Management Resources 
were stored in the same repository. For detailed steps, see Migrate a Management Resource 
with No dfPower Repository. 
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Changes to Repositories and Management Resources 
This section outlines the changes to the repository including the meaning, interface, and 
storage, as well as the changes related to the DataFlux Data Management Server. 
 

The Meaning of "Repository" Has Changed 

In DataFlux dfPower Studio, you can have two independent storage areas for metadata: a 
database storage area called a repository, and a file-based storage area called a 
Management Resource. Some of the main items that are associated with each area are 
shown here. 

 

In DataFlux Data Management Studio, you can have a database storage area and a file 
storage area, but these two areas are not independent. The database storage area (called 
data storage) and the file storage area are bound together under a single ID, in a single 
entity called a repository. Some of the main items that are associated with each area are 
shown here. 
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Storing metadata in a single entity enables DataFlux Data Management Studio to present 
metadata in a single user interface. For example, business rules and tasks are displayed in 
the same interface that displays jobs and reports. However, the revised architecture puts 
new constraints on where items can be stored. Those constraints include the following: 

• Each DataFlux repository must have a data storage area. The file storage area is 
optional. 

• Each DataFlux repository can have at most one data storage area and one file storage 
area. 

All related items must be stored in the same DataFlux repository. This means, for example, 
that a job or profile that is stored in a repository can reference only those business rules, 
tasks, or similar items that are stored in the same repository. 

Differences in metadata architecture might require you to make some manual adjustments 
when you migrate DataFlux dfPower Studio repositories and Management Resources to 
DataFlux Data Management Studio. For more information, see Plan the Migration of Each 
Repository and Management Resource. 

New Repository Interfaces 

In DataFlux Data Management Studio, the Add New Repository Definition dialog box is 
used to add repositories. 
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The Data storage area of the dialog box is similar to the location of a dfPower repository. 
The File storage area of the dialog box is similar to the location of a dfPower Management 
Resource.  

In DataFlux Data Management Studio, the Data storage area and the File storage area are 
bound together under a single ID, in a single entity called a repository. With this change, it 
is possible to have a repository that specifies: 

• a Data storage area only 

• a Data storage area and a File storage area 

It is not possible for a DataFlux repository to specify only a File storage area. 

The Repository Definitions folder in the Administration riser is used to manage the list of 
available repositories. 

 

In the previous display, there are two repository definitions: DataFlux Sample and 
New_Repos. 
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The Folders riser is where you manage the items in a repository. In the Folders tree shown 
in the next display, the Group Items by Type control at the top of the tree is selected. 

 

The Group Items by Type controller groups items into system-defined folders that are 
named after general types, such as Architect Jobs, Business Rules, and so on. A description 
of all of the standard object types is displayed on the right. 

If you deselect the Group Items by Type control, items are grouped into user-defined 
folders, as shown in the next display. 
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In the previous display, the standard folders for deployable jobs are shown: batch_jobs, 
data_services, and process_services. For more information about these folders, see 
Changes Related to the DataFlux Data Management Server. For more information about the 
Administration riser and the Folders riser, see the Overview of the Interface and the 
Repositories sections of the latest version of DataFlux Data Management Studio online 
Help. 

Changes in Repository Storage 

Some changes in the databases and operating systems can be used for DataFlux Data 
Management Studio repository storage. For more information, see Repository Storage in 
the latest version of DataFlux Data Management Studio: Installation and Configuration 
Guide. 

Changes Related to the DataFlux Data Management Server 

The DataFlux Data Management Server is a new version of the DataFlux Data Integration 
Server. Jobs can be uploaded from DataFlux Data Management Studio to a DataFlux Data 
Management Server, where the jobs are executed. 

The DataFlux Data Management Server can execute both DataFlux Data Management Studio 
jobs and dfPower jobs. You can upload jobs from dfPower to the DataFlux Data Management 
Server for execution. 

If you used a DataFlux Data Integration Server with security enabled, and you plan to 
continue to do so when moving to DataFlux Data Management Studio, then you must 
regenerate and reconfigure all security ACL files. Enhancements made to DataFlux Data 
Management Server preclude the use of existing ACL files. For more information, see the 
DataFlux Data Management Server: Administrator's Guide. 

Multiple repositories can be active on a DataFlux Data Integration Server, but only one 
repository can be active on a DataFlux Data Management Server. If your site requires 
multiple repositories, then you must install multiple data management servers. 

The standard folders for deployable jobs (batch_jobs, data_services, and process_services) 
should always exist in a DataFlux Data Management Studio repository and in a DataFlux 
Data Management Server repository. Mirroring these folders help preserve any references 
where one DataFlux Data Management Studio job references another. 
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A set of standard folders for deployable jobs are usually added automatically when you add 
a new repository in DataFlux Data Management Studio and you specify a File storage 
location. To display the standard folders in the Folders tree, put the tree in user-defined 
folders mode by de-selecting the Group Items by Type control at the top of the tree. Then 
select and expand the new repository, as shown in the next display. 

 

In the previous display, the standard folders for deployable jobs are shown: batch_jobs, 
data_services, and process_services. If you were to create a data service job in DataFlux 
Data Management Studio, you would save it to the data_services folder. When you deploy 
the job on a DataFlux Data Management Server, you would deploy it to the data_services 
folder on the server. 
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In the previous display, a data service job called service_Sort_Words has been deployed in 
a folder named Real-Time Data Services. The default name of this folder on the server does 
not happen to be data_services, but the physical path for this folder is the path to the 
data_services folder on the server's file system (<server home>\var\data_services). 

Note: The standard folders for deployable jobs are not added automatically 
when you migrate a dfPower repository. Accordingly, you must manually 
create the standard job folders in the migrated repository, if you ever deploy 
DataFlux Data Management Studio jobs to a DataFlux Data Management 
Server. 

One way to add the standard folders for deployable jobs is to use operating system tools, as 
described in General Planning for Repositories. Another way is to add the folders in the 
user-defined folders view of the Folders tree. Perform the following steps. 

1. In DataFlux Data Management Studio, click the Folders riser bar. 

2. If the Folders tree is not in user-defined folders mode, clear the Group Items by 
Type option at the top of the tree. 

3. Select and expand the migrated repository in the Folders tree. 

4. Right-click the repository icon. 

5. Select New > Folder. A new folder is added to the tree. 

6. Name the new folder after one of the standard folders for deployable jobs, such as 
batch_jobs. Make sure that the name is an exact match for the standard folder. 

7. Use the same method to add the other standard folders. 
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Architect Jobs 
Plan the Migration of Architect Jobs 
When migrating from DataFlux dfPower Studio, review the Migrating from DataFlux dfPower 
Studio v. 8.1/8.2 to DataFlux Data Management Studio v. 2.2 to try to anticipate the main 
issues that might affect the conversion of your Architect jobs. It is always best to know as 
much as possible about the Architect jobs that you are migrating. That way, you can 
identify changes and possible problems after migration. Also, it is easier to test the 
migrated jobs if you have a basic understanding of DataFlux Data Management Studio data 
jobs and process jobs, as described in the Data Jobs and Process Jobs sections of the 
DataFlux Data Management Studio online Help. 

Changes to Architect Jobs 
Several differences exist between DataFlux dfPower Studio and DataFlux Data Management 
Studio. Those differences are described in the following sections: 

• New Job Architecture 

• New Job Interfaces 

• New Storage Constraints 

• Other Changes 

New Job Architecture 

DataFlux Data Management Studio has two types of jobs that are used for data integration: 
data jobs and process jobs. Data jobs are the main way to process data in DataFlux Data 
Management Studio. Each data job specifies a set of data-processing operations that flow 
from source to target, illustrated here. 

 
Data Job Specifies Set of Data-processing Operations 
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Process Jobs Combine Data Processing with Conditional Processing. 

The process flow in the job supports logical decisions, looping, events, and other features 
that are not available in a data job flow. Data Job nodes can be added to a process flow to 
encapsulate all of the data processing power of a data job into a node in the process flow. 

 
Data Job Nodes Can Be Added to a Process Flow 

Some Architect Jobs Can Be Converted to Either a Data Job or a Process Job. 

Other Architect jobs must be converted to one of these job types. In either case, the 
upgrade job wizards enable you to perform a correct conversion, as described later. 

New Job Interfaces 

Data jobs and process jobs have a similar editor. The next display shows the data job 
editor. 

 
Data Job Editor 
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For more information about using the Data Job Editor and the Process Job Editor, see the 
Data Jobs and Process Jobs sections of the DataFlux Data Management Studio online 
Help. 

The Folders riser is where you manage Architect jobs before and after they have been 
converted to DataFlux Data Management Studio jobs. In the Folders tree shown here, the 
Group Items by Type control is selected. 

 
Group Items by Type Selected 

The Group Items by Type controller groups items into system-defined folders that are 
named after general types, such as Architect Jobs, Business Rules, and so on. The Architect 
Jobs folder contains Architect jobs in their original, dfPower format, after you have copied 
them to the File storage area of the migrated repository. You cannot open Architect jobs 
that have not been converted to DataFlux Data Management Studio format. 
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If you deselect the Group Items by Type control, items are grouped into user-defined 
folders, as shown here. 

 
Group Items by Type Not Selected 

New Storage Constraints 

As explained in New Repository Architecture, DataFlux Data Management Studio has new 
constraints on where jobs can be stored. Those constraints include the following: 

• Each DataFlux repository can have at most one data storage area and one file storage 
area. 

• All related items must be stored in the same DataFlux repository. This means, for 
example, that a job that is stored in a repository can reference only those business 
rules, tasks, or similar items that are stored in the same repository. 

Differences in metadata architecture might require you to make some manual adjustments 
when you migrate dfPower repositories and Management Resources to DataFlux Data 
Management Studio. For more information, see Plan the Migration of Each Repository and 
Management Resource. 

Other Changes 

See Post-Migration Tasks for Architect Jobs. 
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Profile Jobs 
The meaning of "profile" has changed from DataFlux dfPower Studio and new constraints 
exist on where those profiles can be stored.  

Changes to Profile Jobs:  
In DataFlux dfPower Studio, a profile job and its report are separate objects. In DataFlux 
Data Management Studio, a profile job and its report have been merged into a single object, 
and this object is simply called a profile. The profile dialog box in DataFlux Data 
Management Studio has separate tabs for the base properties of the profile and the 
properties of its report, as shown in the next display. 
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Profiles can be viewed from the Profiles folder in the Folders tree, when the Group Items 
by Type control is selected at the top of the tree, as shown in the next display. 
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Profiles can also be viewed from user-defined folders in the Folders tree, when the Group 
Items by Type control is de-selected, as shown in the next display. 

 

New Storage Constraints 
As explained in New Repository Architecture, DataFlux Data Management Studio has new 
constraints on where profiles can be stored. Those constraints include the following: 

• Each DataFlux repository can have at most one data storage area and one file storage 
area. 

• All related items must be stored in the same DataFlux repository. This means, for 
example, that a profile that is stored in a repository can reference only those business 
rules, tasks, or similar items that are stored in the same repository. 

Differences in metadata architecture might require you to make some manual adjustments 
when you migrate DataFlux dfPower Studio repositories and Management Resources to 
DataFlux Data Management Studio. For more information, see Plan the Migration of Each 
Repository and Management Resource. 
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Macros 
As part of the migration, you have new macro configuration files and syntax changes.  

Plan the Migration of Macros 
The files and folders where macro variable definitions can be stored have changed. The new 
macro configuration files are described in the "Macro Variables" section in the DataFlux Data 
Management Studio: User's Guide. If you move your DataFlux dfPower Studio macro 
variable definitions into one or more DataFlux Data Management Studio configuration files, 
and you use these macro variables in the properties of a node, or in expressions using %% 
notation, or in any instance of the getvar() function, then your DataFlux dfPower Studio 
macro variables frequently work in DataFlux Data Management Studio without further 
modification. 

The syntax for macro variable definitions has changed. This change could affect any item 
that uses a macro variable, such as an Architect job, profile, business rule, or task. In 
DataFlux Data Management Studio, all characters after the equal sign (=) and before the 
newline character become part of the definition. This means, for example, that you should 
not use spaces, quotation marks, or other characters after the equal sign unless you want 
them to be part of the text that is retrieved when the macro variable is called. For more 
information, see the "Macro Variables" section in the latest version of the DataFlux Data 
Management Studio: User's Guide. 

Macros can have other impacts as well. For more information, see the topics related to 
macros in the following sections of this guide: 

• Architect Jobs That Use Macro Variables 

• Architect Jobs That Pass Macro Variable Values Dynamically Between Pages in the Job 

• Rules and Related Items That Use Macro Variables 

• Profile Jobs That Contain Macro Variables 
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Business Rules, Tasks, and Related Items 
Plan to Migrate Business Rules, Tasks, and Related Items 
DataFlux dfPower Studio business rules, tasks, custom metrics, and other items in the 
Business Rules Manager are migrated only when their repository is migrated. You cannot 
migrate individual rules and related items from DataFlux dfPower Studio. 

Post-Migration Tasks for Business Rules, Tasks, and 
Related Items 

Rules and Related Items That Use Macro Variables 

When a macro variable was used in a DataFlux dfPower Studio task, the Data Monitoring 
node that is referencing this task probably needs to be updated before it works in DataFlux 
Data Management Studio. General updates for macros are described in Macro Variables. 

Macro Variables, Rules, and Tasks 

If an Architect job references a rules or task, and the rule or task dynamically retrieves or 
sets the value of a macro variable, then the Data Monitoring node that references such a 
task must be updated. Such a job is shown in the next display. 

 

To pass macro variable values to a rule that is included in the Data Monitoring node 
shown in the previous display, you would right-click the Data Monitoring node and select 
Advanced Properties. Then you would specify the macro variable in the KEY_VALUES 
property. 

To get macro variable values out of a rule that is included in the Data Monitoring node 
shown in the previous display, you would right-click the Data Monitoring node and select 
Advanced Properties. Then you would specify the macro variable in the 
OUT_KEY_VALUES property. 
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Chapter 4: Specific Migration 
Scenarios 
 

IMPORTANT: The Specific Migration Scenarios section is intended for users 
who have read the General Information section or for those who have a good 
understanding of what is needed and simply need some guidance on stepping 
through the migration steps. In the Specific Migration Scenario section, each 
sub-section builds on the previous section. Therefore, if you jump straight to 
the migrating Architect jobs section without completing the Repository 
migration section, you will have problems with the migration steps. 

 

Select the appropriate migration option: 

• Migrating from DataFlux dfPower Studio 8.1/8.2 to DataFlux Data Management Studio 

• Migrating from DataFlux Integration Server 8.1/8.2 to DataFlux Data Management 
Server 

• Migrating from DataFlux Data Management Studio 2.1 to DataFlux Data Management 
Studio 2.2 or Later 

• Migrating from DataFlux Data Management Server 2.1 to DataFlux Data Management 
Server 2.2 or Later 
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DataFlux dfPower Studio 8.1/8.2 to DataFlux 
Data Management Studio 
Each migration scenario requires specific actions. Refer to each of the following sections: 

• Configurations 

• Reference Sources 

• Data Connections 

• Repositories 

• Architect Jobs 

• Profile Jobs 

• Explorer Jobs 

• Accelerators 

• Command Line Execution 

• SAS Data Integration Studio 

• Other 

Note: This section uses DataFlux Data Management Studio or Server 2.2 as the 
example target system. Anything that is different in version 2.3 or later is 
explicitly identified. 

Configurations 
DataFlux dfPower Studio v. 8.1 stored configuration settings in the registry as well as in 
architect.cfg. You need to take these settings out of those two locations and move them into 
the appropriate DataFlux Data Management Studio configuration files as well as map to the 
DataFlux Data Management Studio configuration setting. 

Below is a list of dfPower settings and what they map to in DataFlux Data Management 
Studio. You need to copy the values that are in the dfPower configuration files or Windows 
registry to the DataFlux Data Management Studio configuration files. In doing so, please 
note several differences between the configuration files: 

• Numeric values in DataFlux Data Management Studio need to be written out. Values in 
DataFlux dfPower Studio could be 10m, which represents 10 million. In DataFlux Data 
Management Studio, this must be written as 10000000. 

• DataFlux Data Management Studio does not require configuration values to be 
enclosed in single quotation marks. 

• Double quotation marks are not special in DataFlux Data Management Studio 
configuration files. 
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• To escape characters (", =, white space, and so on) in DataFlux Data Management 
Studio configuration files enclose them in single quotation marks. 

In the following table, look at the DataFlux dfPower Studio architect.cfg file, find the 
configuration from the file in the "dfPower Setting" column, look to the left to see the 
DataFlux Data Management Studio equivalent setting found in the first column, and put the 
value in the file identified in column two. For example, in the architect.cfg file, we have the 
following: 

 

To find the equivalent setting in Data Management Studio, look in the "dfPower Setting" 
column to find "CLUSTER/BYTES". 

 

From here, you can tell that the DataFlux Data Management Studio equivalent setting is 
CLUSTER/BYTES (column one) and that the value lives in app.cfg (column two). Open up 
the DataFlux Data Management Studio app.cfg file and locate "CLUSTER/BYTES" (press 
CTRL+F) and look for the DataFlux Data Management Studio configuration which, in this 
case, is also CLUSTER/BYTES 

 

By default, there is no value. Modify the app.cfg and insert the dfPower setting. 
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Be sure to check both locations. If you discover that both locations have values in them and 
the values are different, dfPower is using the value from the architect.cfg. This is the value 
that you need to copy over to DataFlux Data Management Studio. 

DataFlux Data 
Management Studio 

Settings 

DataFlux Data 
Management 
Studio File 

dfPower 
Setting dfPower File/Registry 

BASE/DATE_FORMAT app.cfg -- -- 
BASE/EMAILCMD app.cfg EMAILCMD (architect.cfg) 
BASE/FTPGETCMD app.cfg FTPGETCMD (architect.cfg) 
BASE/FTPPUTCMD app.cfg FTPPUTCMD (architect.cfg) 
BASE/LOGEXCEPTIONS app.cfg -- -- 
BASE/MACROS_PATH app.cfg -- -- 
BASE/PRIMARY_LICENSE app.cfg -- -- 
BASE/PRIMARY_LICENSE
_LOC 

app.cfg License HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\Environment 
HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower Studio\8.1\DIS 
Environment  

BASE/SECONDARY_LICE
NSE 

app.cfg -- -- 

BASE/SECONDARY_LICE
NSE_LOC 

app.cfg -- -- 

BASE/SORTBYTES app.cfg SORTBYTES 
SortBytes Sort 
chunk 
(dfexec.cfg)  

(architect.cfg) 
HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower Studio\8.1\DIS 
Environment  

BASE/SORTMERGES app.cfg SORTMERGES -- 
BASE/SORTTEMP app.cfg SORTTEMP -- 
BASE/SORTTHREADS app.cfg SORTTHREADS -- 
BASE/TEMP app.cfg TEMP (architect.cfg) 
BASE/TEXTMINE_LITI_LA app.cfg -- -- 
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DataFlux Data 
Management Studio 

Settings 

DataFlux Data 
Management 
Studio File 

dfPower 
Setting dfPower File/Registry 

NG_LOCATION 
CLUSTER/BYTES app.cfg CLUSTER/BYTE

S ClusterBytes  
(architect.cfg) 
HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\ARCHITECT  

CLUSTER/LOG app.cfg CLUSTER/LOG (architect.cfg) 
CLUSTER/TEMP app.cfg -- -- 
ENVIRONMENT/SASDIS ui.cfg SASDIS HKEY_LOCAL_MACHINE\SOFTWARE\

Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\Environment\ 

JAVA/VMLIB app.cfg JAVA/VMLIB -- 
PROF/PER_TABLE_BYTES app.cfg fd table 

memory 
(dfexec.cfg) 

PROF/LOCK_RETIRES app.cfg -- -- 
PROFCONFIG/METRIC0 ui.cfg -- -- 
PROFCONFIG/METRIC1 ui.cfg -- -- 
PROFCONFIG/METRIC2 ui.cfg -- -- 
PROFCONFIG/METRIC3 ui.cfg -- -- 
PROFCONFIG/METRIC4 ui.cfg -- -- 
PROFCONFIG/METRIC5 ui.cfg -- -- 
PROFCONFIG/METRIC6 ui.cfg -- -- 
PROFCONFIG/METRIC7 ui.cfg -- -- 
PROFCONFIG/METRIC8 ui.cfg -- -- 
PROFCONFIG/METRIC9 ui.cfg -- -- 
PROFCONFIG/METRIC10 ui.cfg -- -- 
PROFCONFIG/METRIC11 ui.cfg --   
PROFCONFIG/METRIC12 ui.cfg -- -- 
PROFCONFIG/METRIC13 ui.cfg -- -- 
PROFCONFIG/METRIC14 ui.cfg -- -- 
PROFCONFIG/METRIC15 ui.cfg -- -- 
PROFCONFIG/METRIC16 ui.cfg -- -- 
PROFCONFIG/METRIC17 ui.cfg -- -- 
PROFCONFIG/METRIC18 ui.cfg -- -- 
PROFCONFIG/METRIC19 ui.cfg -- -- 
PROFCONFIG/METRIC20 ui.cfg -- -- 
PROFCONFIG/METRIC21 ui.cfg -- -- 
PROFCONFIG/METRIC22 ui.cfg -- -- 
PROFCONFIG/METRIC23 ui.cfg -- -- 
PROFCONFIG/METRICFRE ui.cfg -- -- 
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DataFlux Data 
Management Studio 

Settings 

DataFlux Data 
Management 
Studio File 

dfPower 
Setting dfPower File/Registry 

QDIST 
PROFCONFIG/METRICFRE
QPAT 

ui.cfg -- -- 

PROFCONFIG/METRICOU
TLIERS 

ui.cfg -- -- 

PROFCONFIG/METRICOU
TMAX 

ui.cfg -- -- 

PROFCONFIG/METRICOU
TMIN 

ui.cfg -- -- 

PROFCONFIG/METRICPCT
INTERVALS 

ui.cfg -- -- 

PROFCONFIG/METRICPER
CENTILES 

ui.cfg -- -- 

PROFVIEW/METRIC0 ui.cfg Metric0 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC1 ui.cfg Metric1 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC2 ui.cfg Metric2 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC3 ui.cfg Metric3 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC4 ui.cfg Metric4 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC5 ui.cfg Metric5 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC6 ui.cfg Metric6 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 
 

PROFVIEW/METRIC7 ui.cfg Metric7 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 
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DataFlux Data 
Management Studio 

Settings 

DataFlux Data 
Management 
Studio File 

dfPower 
Setting dfPower File/Registry 

PROFVIEW/METRIC8 ui.cfg Metric8 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC9 ui.cfg Metric9 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC10 ui.cfg Metric10 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC11 ui.cfg Metric11 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC12 ui.cfg Metric12 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC13 ui.cfg Metric13 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC14 ui.cfg Metric14 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC15 ui.cfg Metric15 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC16 ui.cfg Metric16 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC17 ui.cfg Metric17 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC18 ui.cfg Metric18 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC19 ui.cfg Metric19 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
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DataFlux Data 
Management Studio 

Settings 

DataFlux Data 
Management 
Studio File 

dfPower 
Setting dfPower File/Registry 

Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC20 ui.cfg Metric20 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC21 ui.cfg Metric21 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC22 ui.cfg Metric22 HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\PROFVIEW 

PROFVIEW/METRIC23 ui.cfg -- -- 
QKB/ALLOW_INCOMPAT app.cfg -- -- 
QKB/COMPATVER app.cfg -- -- 
QKB/PATH app.cfg BLUEFUSION/Q

KB QKB root  
(architect.cfg) 
(architect.cfg)  

QKB/SURFACEALL app.cfg -- -- 
VERIFY/BF (software 
does not recognize) 

app.cfg VERIFY/BF (architect.cfg) 

VERIFY/CACHESIZE app.cfg VERIFY/CACHE
SIZE Verify 
cache 
VerifyCache 

(architect.cfg) 
(dfexec.cfg) 
(HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\ARCHITECT)  

VERIFY/CANADA app.cfg VERIFY/CANAD
A 

(architect.cfg) 

VERIFY/GEO app.cfg VERIFY/GEO (architect.cfg) 
VERIFY/PRELOAD app.cfg VERIFY/PRELO

AD 
(architect.cfg) 

VERIFY/USEDPV app.cfg VERIFY/USEDP
V 

(architect.cfg) 

VERIFY/USEELOT app.cfg -- -- 
VERIFY/USELACS app.cfg -- -- 
VERIFY/USERDI app.cfg VERIFY/USERD

I 
(architect.cfg) 

VERIFY/USPS app.cfg VERIFY/USPS 
USPS db 
USPSDir  

(architect.cfg) 
(dfexec.cfg) 
HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\DataFlux 
Corporation\dfPower 
Studio\8.1\VERIFY  
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DataFlux Data 
Management Studio 

Settings 

DataFlux Data 
Management 
Studio File 

dfPower 
Setting dfPower File/Registry 

VERIFY/USPSINST app.cfg VERIFY/USPSI
NST 

(architect.cfg) 

VERIFYINTL/CFG app.cfg VERIFYINTL/CF
G 

(architect.cfg) 

VERIFYWORLD/DB app.cfg VERIFYWORLD
/DB 

(architect.cfg) 

VERIFYWORLD/UNLK app.cfg VERIFYWORLD
/UNLK 

(architect.cfg) 

Configuration Values from DataFlux dfPower Studio to DataFlux Data Management Studio 

If any Accelerators are installed with your dfPower installation, it is not recommended that 
the associated macros be moved over. You should download the appropriate version of the 
Accelerator that works with your version of DataFlux software. Therefore, when you are 
viewing the architect.cfg file, you should not move over macros with the following prefixes: 

• MDI_ 

• MDC_ 

• SA_ 

• ACDQ_ 

• CDC_ 

• CDA_ 

• WLC_ 

• MDM_ 

Any remaining macros in architect.cfg that are not in the dfPower to DataFlux Data 
Management Studio table or are Accelerator macros, are most likely user-defined macros. 
These remaining macros should be moved to a new file in the 
<DM_STUDIO_INSTALL_ROOT>/etc/macros/ directory. Do not place them in any of the 
DataFlux Data Management Studio specific configuration files. 

IMPORTANT! If you see a macro that is not user-defined and you believe 
that it is a DataFlux setting, please contact DataFlux technical support. 

In this dfPower example, the macro called OUTPUT_PATH needs to be moved over. 

 

Go to Windows Explorer and navigate to the install root for DataFlux Data Management 
Studio; in this case, it is the default C:\Program Files (x86)\DataFlux\DMStudio\2.2. 
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Go into the etc\macros directory and create a new text file called 81macros.cfg. Click Yes to 
confirm the change of the extension from .txt to .cfg. 

 

Open the 81macros.cfg file and copy the value from architect.cfg: 

 

Now, you can view the new macro file and values if you access version 2.2. 

Repeat these steps for each user-defined macro. Initially, it is recommended that all 
dfPower user-defined macros be placed in the same file. 
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Data Quality Functions 

If the migration includes a new Quality Knowledge Base (QKB), it is a best practice to 
regenerate any static data quality pieces such as match codes. This is because changes in 
the QKB can result in a slightly different match code being generated. 

If you are using dfPower Studio v. 8.2 and you are not changing QKBs as part of your 
migration, see Migrating from DataFlux dfPower Studio v. 8.1/8.2 to DataFlux Data 
Management Studio v. 2.2 for more information about how to configure DataFlux software 
so that it uses data quality functions as they were used in DataFlux dfPower 8.2. 

IMPORTANT: It is strongly recommended that you do this only if it is 
necessary. 

Reference Sources 
The data packs for USPS, Canada, Geocode, and Phone data as well as World data must be 
re-registered in DataFlux Data Management Studio. The easiest way to accomplish this is to 
have both DataFlux dfPower Studio and DataFlux Data Management Studio open. 

In DataFlux dfPower Studio, open Reference Sources. 

 

Click on the properties for each line under the USPS Data, Canada Post Data, GEO+Phone 
Data, and World Data tabs. 
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Copy the Name and Directory into the Add Reference Source dialog box in DataFlux Data 
Management Studio, which is found in the Administration riser bar under the Reference 
Sources folder. 

 

The one difference here is that you need to make sure the type reflects the dfPower tab 
where the information is coming from. 

Be sure to check the Set as default option if this reference source should be used during 
job execution. If Private remains selected, this sets the proper values in the app.cfg located 
in %APPDATA%\DataFlux\DataManagement\2.2 (Note that you can copy and paste that 
string into Windows Explorer and it takes you to the correct location. If the location does not 
exist, it is because you have not run DataFlux Data Management Studio yet. These 
directories are created when the application is run for the first time.) If this installation is 
being shared with others, it is recommended to also uncheck the Private option. This stores 
the setting in the system app.cfg file.\ 

 

 

 

 

 

DataFlux Data Management Studio 2.3 and later: 

• Personal settings have moved in 2.3 and later. Data Management Studio and 
Server now support multiple instances on one box. Settings per instance are 
stored in %APPDATA%\DataFlux\DMStudio\<instance>\etc. 
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Data Connections 
If DataFlux Data Management Studio is being installed on the same machine where the 
previous version of DataFlux dfPower Studio was installed, no additional steps are required 
to migrate over any ODBC connections. If DataFlux Data Management Studio is being 
installed on a new machine, then you much migrate the ODBC connections defined in the 
ODBC Administrator manually. 

ODBC data connections that are defined on the machine are upgraded automatically to the 
latest version of the DataFlux ODBC drivers. This means that both DataFlux dfPower Studio 
and DataFlux Data Management Studio are using the same version of ODBC drivers. 

The only action required is to move over any saved credential files that are stored. These 
can be found in %APPDATA%\DataFlux Corporation\dfdac and should be copied to 
%APPDATA%\DataFlux\dac\9.1. 

 

 

 

 

In DataFlux dfPower Studio v. 8.1, there is the following connection with saved credentials 

 

This correlates to a file in %APPDATA%\DataFlux Corporation\dfdac: 

 

DataFlux Data Management Studio 2.3 and later: 

• Saved credentials are stored in %APPDATA%\DataFlux\dac\savedconn. Data 
Management Studio still reads saved configurations from 
%APPDATA%\DataFlux\dac\9.1. 
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For DataFlux Data Management Studio 2.3 and later versions, copy this file to 
%APPDATA%\DataFlux\dac\savedconn. For DataFlux Data Management Studio 2.2 copy this 
file to %APPDATA%\DataFlux\dac\9.1: 

 

This now appears in DataFlux Data Management Studio as an ODBC connection with saved 
credentials: 

 

 

 

 

DataFlux Data Management Studio 2.3 and later: 

For DataFlux Data Management Studio 2.3 and later versions, make sure that all .cfg 
files are in %APPDATA%\DataFlux\dac\savedconn. For DataFlux Data Management 
Studio 2.2 make sure that all .cfg files are in %APPDATA%\DataFlux\dac\9.1. 

 



 
DataFlux Migration Guide 47 
 

Use a utility of choice to copy over the saved credentials. First, confirm there is not anything 
in the dac\9.1 folder. 

 

Confirm that the configuration file was moved as shown in the following display: 
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Repositories 
This section reviews how to migrate file-based as well as DBMS-based DataFlux dfPower 
Studio repositories to DataFlux Data Management Studio. 

Migrating a file-based Repository is appropriate under the following conditions: 

• The dfPower repository is in SQLite format (an RPS file) 

• Jobs in a Management Resource refer to rules and tasks in the dfPower repository 

• The dfPower repository is not managed by a DataFlux Data Integration Server 

• The migrated repository is not managed by a DataFlux Data Management Server 

In general, you create an empty folder structure such as the structure described in General 
Planning for Repositories. Creating such a structure ensures that you have the standard 
folders for deployable jobs. Copy the dfPower repository to an appropriate folder in that 
structure. When you run the New Repository Definition wizard, specify the location of the 
copied dfPower repository and the location of an empty set of folders. Later, copy Architect 
jobs into these folders. 

Migrating a DBMS-based Repository is appropriate under the following conditions: 

• The dfPower repository is in DBMS format (not SQLite) 

• Jobs in a Management Resource refer to rules and tasks in the dfPower repository 

• The dfPower repository is not managed by a DataFlux Data Management Server 

• The migrated repository is not managed by a DataFlux Data Management Server 

In general, you use DBMS commands to create a copy of the dfPower repository and create 
a new DBMS connection to the copy. Then you convert the dfPower repository. 

The next few sections provide specific steps to follow to create a DataFlux Data 
Management Studio Repository. 

• Copying a File-Based Repository 

• Copying a DBMS-Based Repository 

• Copying Over Files 

• Create the v. 2.2 Repository 
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Copying a File-Based Repository 

This section provides a step-by-step walk-through on how to migrate a dfPower Repository 
and Management Resource to a DataFlux repository. 

First, back up your dfPower Repository. This can be by opening DataFlux dfPower Studio 
and then opening the Repositories. 

 

Select and right-click on a repository, and then select Copy Repository. 

 

In the Copy Repository dialog box, enter the necessary information in the available fields. 
This information is specific to your needs. 

Note: It is a good idea to make the copy the same type as the original. 
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When you are finished, you should see a copy in the Repositories list: 
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Copying a DBMS-Based Repository 

This is an example for a database-sourced repository. This example uses Oracle as the 
database with an approach to create a new schema that contains the copy. This means that 
you need to register a new DSN and then use this DSN to hold the copy. The copy of the 
repository could be stored in the same schema, but it is recommended to store in a 
separate schema to keep a clean separation between environments. 

The Database Connections screen looks like this: 

 

This is the repository screen showing the registered 81 Repo DSN: 
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After the second DSN that contains the copy is created, you will have this in the Database 
Connections screen: 

 

Now, you need to copy the 81 Repo to the 81 Repo Copy DSN: 
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It is highly recommended that the Table prefix option be used to identify this is a copy. 
Even if the recommendation of putting the copy in a different schema were used, this would 
be another way to identify quickly that this is not an original repository. 

 

Copying Files 

No matter the dfPower repository type, File, or DBMS based, before the dfPower version 
repository can be used to create a DataFlux repository, you must create the file storage 
aspect of the DataFlux repository. To do this, copy the jobs from the Management 
Resources location to the folder structure that you want to use in DataFlux Data 
Management Studio. Please review the Repositories and Management Resources section for 
more information. 

For this example, assume that you have set up new file storage under the 
C:\ProgramData\DataFlux\DataManagement\2.2\Repository location, called 81 Repos. 
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Under this location, create the following hierarchy: 

• FileStorage\architecct81 

• FileStorage\profile81 

• FileStorage\realtimesvcs81 
 

 

In each location, copy the jobs that need to be converted. Note that this can be from 
multiple Management Resource locations. DataFlux Data Management Studio can handle 
multiple repositories but DataFlux Data Management Server can support only one repository 
connection. This should factor in when trying to organize repositories. 

In the dfPower system, there are three Management Resources locations. All three are 
moved to one location for DataFlux Data Management Studio. 

 

All of the Architect jobs go into the FileStorage\architect81 folder. The same Management 
Resources structure is used. This makes it easier to remember and even synchronize the 
folder locations post migration. 
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All Profile jobs are moved into the FileStorage\profile81 folder and the real-time service jobs 
are moved into the FileStorage\realtimesvcs81 folder. Use a utility of choice to copy the 
*.dmc files over.  

This display shows how the files are arranged prior to the move: 

 

All the Architect jobs are copied to the FileStorage\architect81\81Sample location. There are 
two things to note from this action. First, you moved everything into the 81Sample folder. 
This is done to identify that the jobs have been moved from an 8.1 location. This is 
recommended as a best practice. A second thing to note is that we only copied over the 
Architect jobs. If everything needs to be moved over, do not restrict by extension. 
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Repeat this for each of the types to be moved over and for each Management Resources 
location. 

 

Create the New Repository 

 

 

 

 

Once all the jobs are copied into the new locations, you need to register the copy of the 
dfPower repository in DataFlux Data Management Studio. If DataFlux Data Management 
Studio is running on a different system from which DataFlux dfPower Studio is running, note 
that the 81 Repo Copy DSN needs to be created. In DataFlux Data Management Studio, go 
to the Administration riser, select Repository Definitions, and create a new repository. 

 

DataFlux Data Management Studio 2.3 and later: 

• The following details what to do in DataFlux Data Management Studio 2.2. The 
steps are the same for DataFlux Data Management Studio 2.3 and later. 
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Give it a meaningful name, choose the database copy that was created earlier and then 
select the C:\ProgramData\DataFlux\DataManagement\2.2\Repository\81 Repos\FileStorage 
folder created earlier. 

 

If using a file-based repository, the Repository Definition should look something like this: 
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When you save the DataFlux Data Management Studio configuration, DataFlux Data 
Management Studio notifies you that the repository needs to be upgraded. This is OK and a 
good sign that the system has recognized that you have an older version and it needs to be 
updated. 

 

Click OK. You should now see something that indicates that the repository needs to be 
upgraded. Right-click on the repository and choose Upgrade. 

 

When prompted to confirm the upgrade, select Yes. 
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Once the upgrade process finishes running, a confirmation notifies you that the upgrade 
completed successfully. 

 

When the upgrade is done, connect to the repository. The Connected label appears when 
you are connected to the repository. 

 

Also, the Folders riser now displays the contents. 
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Once the jobs are moved over, you need to upgrade them so that they can be edited or run 
in DataFlux Data Management Studio. 

You should be able to bring up the Business Rule Manager and confirm that all the DataFlux 
dfPower Studio Tasks, Rules, and other objects are available in the DataFlux repository. It 
should be noted that you will see many more Rules and Tasks after the upgrade. These 
Rules and Tasks are associated with the DataFlux Master Data Management Foundations 
feature in DataFlux Data Management Studio. For more information about this feature, refer 
to the DataFlux Data Management Studio online Help. 

Migrate a Management Resource with No dfPower Repository 

This topic is appropriate when you want to migrate a Management Resource that does not 
refer to rules and tasks in a DataFlux dfPower Studio repository, as described in Migration 
Scenario: No dfPower Repository, One or More Management Resources. 

In general, you create an empty folder structure such as the structure described in General 
Planning for Repositories. Creating such a structure ensures that you have the standard 
folders for deployable jobs. When you run the New Repository Definition wizard, specify the 
location of an empty folder where the new DataFlux Data Management Studio repository 
should be added. You would also specify the location of an empty set of folders. Later, copy 
Architect jobs into these folders. 

Complete the following steps: 

1. Create an empty folder structure to hold the new DataFlux Data Management Studio 
repository and related assets, as described in General Planning for Repositories. 

2. Run DataFlux Data Management Studio. 

3. Click the Administration riser bar. Then select the Repository Definitions folder in 
the Administration tree. The Repository Definitions pane is displayed on the right. 

4. In the Repository Definitions pane, click New to create the new repository. The New 
Repository Definition dialog box appears. 

5.  Enter the name of your repository in the Name field. 

6. In the Data storage section of the dialog box, specify a new Database file for the 
DataFlux Data Management Studio repository that you want to create. For example, 
you could specify a path such as C:\New_Repos_C\Repository\Repository_New.rps. 
 
Note: Do not create a repository database file (.RPS) in the file storage location that 
you specify in the next step. This practice prevents manipulating the file through 
DataFlux Data Management Studio, and it triggers unneeded update events in the file 
storage area every time the database file is updated. 

7. In the File storage section of the dialog box, specify an appropriate, empty folder from 
Step 1. For example, you could specify a path such a C:\New_Repos_C\File_Storage. 
(Later, copy unconverted dfPower Architect jobs to this area and save the converted 
copies of these jobs to the same area.) 

8. Click OK to save the new repository. You receive a message that asks whether you 
want to create a new repository. 
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9. Click Yes. The repository is created. 

10. Verify that the new repository is working properly by browsing its contents. See 
Browsing the Results After Migration. 

11. Copy the relevant Architect jobs from one or more Management Resources to an 
appropriate folder in the file storage area of the new repository. 

Post-Migration Tasks for Repositories 

Browsing the Results after Migration 

The following steps demonstrate one way to browse a migrated repository in DataFlux Data 
Management Studio. For this section, you are in DataFlux Data Management Studio and are 
connected to the migrated repository. 

1. To explore the contents of the migrated repository, click the Folders riser. 

2. Select the new repository in the Folders tree. 

3. Toggle between the two main views in the Folders tree by selecting and deselecting 
the Group Items by Type control at the top of the tree. 
 
When the Group Items by Type control is not selected, items are grouped into user-
defined folders, as shown in the next image. 
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The migration process creates some user-defined folders automatically, based on any 
subfolders in the File storage area. Most of the folders in the display were created 
based on the folder structure that is described in General Planning for Repositories. 
These folders are empty at this point because only the items that were in the DataFlux 
dfPower Studio repository (metadata database) have been migrated, not the file-
based items, such as Architect jobs, that are stored in any DataFlux dfPower Studio 
Management Resource. 
 
The Shared Data folder is different. It is automatically created for a migrated dfPower 
repository. It displays any business rules or tasks that were defined in the dfPower 
repository. These items are stored in the Data storage area (metadata database area) 
of the migrated repository, but references to these items are displayed in the Shared 
Data folder for convenience. 

4. When the Group Items by Type control is selected, items are grouped into system-
defined folders that are named after general types, such as Architect Jobs, Business 
Rules, as shown here. 

 

5. With Group Items by Type control selected, expand the migrated repository and 
expand the folders for each type of object. Most of these folders are empty because 
we have migrated only the items that were in the dfPower repository (metadata 
database), not the file-based items, such as Architect jobs, that are stored in any 
DataFlux dfPower Studio Management Resource. 
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The Business Rules folder contains Business Rules that have been converted to 
DataFlux Data Management Studio format and are often ready to use. Similarly, the 
Tasks folder contains any Monitor Tasks (tasks created in the Business Rule Manager) 
that have been converted and are ready to use. For more information, see Business 
Rules, Tasks, and Related Items. 

Miscellaneous Post-Migration Tasks 

Delete Any Data Explorations Migrated from DataFlux dfPower Studio 

The migration software moves DataFlux dfPower Studio Data Explorations into the Folders 
tree in DataFlux Data Management Studio. You cannot use these items in DataFlux Data 
Management Studio, however, so you can delete them. To delete these items after 
migration, click the Folders riser in DataFlux Data Management Studio. Then click the 
Group Items by Type icon at the top of the Folders tree so that items are grouped in 
folders with type names, such as Architect Jobs, Business Rules, and so on, Select the folder 
for Data Explorations. A list of Data Explorations is displayed on the right. Select all of the 
Data Explorations that you want to delete, and then click the X icon in the toolbar. 

 

Architect Jobs 
As part of the migration, you also need to migrate your Architect jobs to either a Data job or 
a Process job. See the Post-Migration Tasks for Architect Jobs for any additional tasks. 

Migrate to a Data Job or a Process Job? 

Use the upgrade job wizards to convert an Architect job to a Process job or a Data job, as 
permitted by the wizards. The wizards evaluate the following conditions: 

• Architect job with a single page that does not have an External Data Provider node 
in the job flow - You can select Upgrade as a Data Job or Upgrade as a Process 
Job. You might want to select Upgrade as a Data Job until you become familiar with 
Process jobs. 

• Architect job with a single page that has an External Data Provider node in the job 
flow - Select Upgrade as a Data Job. If you want to use the Data Provider job in 
multiple jobs, then it is preferable to convert it to a Data job. This enables you to link 
to it from many Process jobs and maintain only one copy of the Data Provider job that 
is used in multiple Process jobs. 

• Architect job with multiple pages - Select Upgrade as a Process Job. If you choose 
Upgrade as a Data Job, you will get an error. 

Using the Folders riser, you are able to select and upgrade the jobs. You can do this in 
batch or one at a time. Refer to Architect Jobs for additional. This provides some guidance 
in the planning and decisions that need to be made when converting Architect jobs. 
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Select the jobs that need to be converted, right-click, and select Upgrade As Data Job. 

Note: If you have Architect jobs that contain multiple pages, they can be 
upgraded only as Process jobs. 

 

The Save As Data Job dialog box appears: 

 

Change the Save in directory to the new directory where they need to be saved. 
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Click Save. Once the upgrade process is complete, you can see the upgraded jobs in the 
batch_jobs folder. 

 

Repeat this process for all Architect jobs. 

Best Practice: 

• Move Architect jobs that are run in batch into the batch_jobs folder 

• Move Architect jobs that are run as real-time services into the data_services folder 

Note: Any folder hierarchy can be put in place under batch_jobs and 
data_services. If you do not store these types of jobs in folders, you can have 
issues later. 
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Architect Jobs That Pass Macro Variable Values Dynamically between Pages in the 
Job 

This topic is appropriate under the following conditions: 

• You had a multi-page Architect job that used the setvar() and getvar() functions to 
dynamically pass macro variable values between pages in the job. 

• You converted this Architect job to a DataFlux Data Management Studio Process job. 

A multi-page Architect job can use the setvar() and getvar() functions to dynamically pass 
macro variable values between pages in the job. A DataFlux Data Management Studio 
process job can use input and output variables to do something similar. The two methods 
are different enough, however, that some manual updates are required when you migrate a 
multi-page Architect job that dynamically passes values between pages in the job. Without 
these updates, the new Process job does not produce the correct output. 

In order to perform these updates, you must understand how the setvar() and getvar() 
functions were used in the original Architect job. Then you must re-create the same 
functionality, using input and output variables. This task is easier if you understand how 
input and output variables are used in Process jobs, as described in the Process Jobs 
section of the latest version of DataFlux Data Management Studio online Help, under 
Create a Process Job. 

Understanding an Architect Job That Passes Macro Variable Values Dynamically 

For the current example, assume that the original Architect job is similar to the 
Add_New_records_macro job shown here: 

 

Notice that the job has two pages: Set Max_ID and Insert Records. 
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On the Set Max_ID page, the flow increments a macro variable NEXT_ID in the Expression 
node: 

hidden integer x 
x = MAX_ID + 1 
setvar("NEXT_ID", x) 

On the Insert Records page, the NEXT_ID macro is used in Sequencer node by setting the 
start number = %%NEXT_ID%%. Here are the Advanced Properties of the Sequencer 
node: 

 

When this job is converted, it is converted as a Process job. If an attempt is made to 
convert the job as a Data job, the following error appears: 
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Once the Architect job is converted to a Process job, the jobs need to be updated to handle 
the macros correctly. In the process job, add the NEXT_ID as both an input and an output 
variable to the data jobs that are in the process job. 

If you look at the job in DataFlux Data Management Studio, the following Output and Input 
values are defined. First, the Outputs for the Data job now represent the Set MAX_ID 
page: 

 

Plus the Inputs of the Data job that represent the Insert Records page: 

 

For the inputs, you must also bind this input variable to the output variable of the first node. 

1. Select the input variable that you created. 

2. Click Source Binding, above the Default Value column for the selected variable. The 
Source Binding dialog box appears. 
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3. In the Source Binding dialog box, select the output variable that should populate the 
input variable that you just defined. For this example, this is the NEXT_ID variable 
for the Data Job 1 node. 

4. Click OK to save the selected binding. The binding appears in the Source Binding 
column for the variable. 

5. Save your changes. You can click the disk icon in the toolbar or select File > Save 
Process Job. 
 
At this point, you have created input and output variables that perform the same 
function as the setvar() and getvar() functions did in the Architect job. Next, run the 
job and verify the output. 

6. Click the first tab in the flow navigation bar in the process editor dialog box to go back 
to the main flow for the Process job. This is the tab with the name of the job (such as 
Add_New_Records_macro). 

7. Run the entire Process job. You can click the Run Process Job icon in the toolbar, or 
select Actions > Run Process Job from the main menu. 

8. Verify that the output is what you expect. 
 

Post-Migration Tasks for Architect Jobs 

After migration is complete, perform these additional tasks if necessary: 

• Inspect Architect Jobs After Migration 

• Architect Jobs That Use Macro Variables 

• Architect Jobs That Contain a Merge File Output Node 

• Architect Jobs That Contain a Match Report Node 

• Architect Jobs That Contain Deprecated Nodes 

Inspect Architect Jobs after Migration 

After you convert an Architect job to a DataFlux Data Management Studio job, perform the 
following steps to verify that the job is working properly. You need a basic understanding of 
DataFlux Data Management Studio jobs, as described in the Data Jobs and Process Jobs 
sections of the latest version of DataFlux Data Management Studio online Help. 

1. Right-click the job in the Folders tree and select Open. The job is opened in a job 
editor. 

2. If appropriate, try to run the job to see whether it works as it did before migration. 
Select Actions > Run Data Job or Run Process Job from the main menu. 

3. The output, status messages, log, and other indicators tell you whether the job ran 
properly and enables you to troubleshoot any errors. 
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Architect Jobs That Use Macro Variables 

You might need to updates some DataFlux dfPower Studio macro variables to make them 
work in DataFlux Data Management Studio Data jobs or Process jobs. General updates for 
macros are described in Macro Variables. 

Macro Variables and Embedded Jobs 

Architect jobs with Embedded Job nodes are converted to Data jobs with Data Job 
(reference) nodes, as shown here: 

 

In this image, Embedded Job 1 is a Data Job (reference) node. To pass macro variable 
values down to the embedded job, right-click the Data Job (reference) node and select 
Advanced Properties. Then specify the macro variable in the KEY_VALUES property. 

To get macro variable values out of the embedded job, right-click the Data Job 
(reference) node and select Advanced Properties. Then specify the macro variable in the 
OUT_KEY_VALUES property. 
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Architect Jobs That Contain a Merge File Output Node 

When you migrate a job that contains the dfPower Merge File Output node, the Merge 
File node is upgraded to an Entity Resolution File Output node. After migration, perform 
these steps to ensure that the job works properly: 

1. In the Folders tree, right-click the DataFlux Data Management Studio job that contains 
the Entity Resolution File Output node and select Open. The job opens in an 
editing window. 

2. In the job flow, right-click the Entity Resolution File Output node and select Edit. 
The properties dialog box for the node displays. 

3. Inspect the path in the Output file field, as shown here: 

 

4. Verify that the file that is specified in the Output File field has a path within the File 
storage area of the current repository. Otherwise, you cannot select and view the 
entity resolution output file in the Folders tree. Use the file selection control to specify 
a new path within the File storage area, if needed. For example, you might specify a 
path such as the following: 
C:\dfMigrate\MANAGEMENT_RESOURCE\reports\entity_resolution\dfPower_Merge_File
_Output_node.sri 

5. Verify that the file that is specified in the Output File field has a .SRI extension. If 
the file does not have a .SRI extension, the extension is automatically changed when 
you click OK to save your changes. 
 
The Entity Resolution File Output node has a new output file format and a new file 
extension, the .SRI file extension. The entity resolution viewer displays only output 
with the .SRI extension. However, the migration software does not automatically 
update the old extension to .SRI. Accordingly, you must update the extension as 
described in this step or otherwise update the extension. 

6. Click OK to save your changes. 

7. Test the job by running it and viewing the entity resolution output file. 
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Architect Jobs That Contain a Match Report Node 

A job that contains a Match Report node can be migrated like other Architect jobs. To view 
Match Report output in DataFlux Data Management Studio, select Tools > Match Report 
Viewer, and then navigate to the Match Report output file (MDF file). 

Architect Jobs That Contain Deprecated Nodes 

The following DataFlux dfPower Studio nodes have been deprecated in DataFlux Data 
Management Studio. They should be deleted and replaced as described below. 

• COM Plugin 

Replace this node with the new Java™ Plugin node. 

• SAS Data Set Source 

To replace this node, define a SAS data set connection in the Data Connections riser, 
and then use the Data Source node to point to the SAS data sets in that connection. 

• SAS Data Set Target (insert) 

To replace this node, define a SAS data set connection in the Data Connections riser, 
and then use the Data Target (Insert) node to point to the SAS data sets in that 
connection. 

• SAS SQL Query 

To replace this node, define a SAS data set connection in the Data Connections riser, 
and then use the SQL Query node to specify a query against a SAS data set. 
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Profile Jobs 
Use a wizard to copy DataFlux dfPower Studio profile jobs and convert those copies to 
DataFlux Data Management Studio profiles. If the current repository was migrated from 
DataFlux dfPower Studio, and profile reports were saved to the DataFlux dfPower Studio 
repository before migration, then these reports are listed in the Linked report section of the 
wizard, as shown here: 

 

If you do not see any reports in the Linked report section, verify that you are connected to 
the correct repository. If you are connected to the correct repository, but you still do not 
see any reports, then you cannot include the dfPower Studio reports in the conversion. You 
need to re-create the reports as described in the Profiles section in the latest version of the 
DataFlux Data Management Studio online Help. 

Perform the following tasks as appropriate: 

• Convert DataFlux dfPower Profile Jobs to DataFlux Data Management Studio Profiles 

• Associate DataFlux Data Management Studio Profiles with DataFlux dfPower Studio 
Reports 

• Unlink a DataFlux dfPower Studio Report from a DataFlux Data Management Studio 
Profile 
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Convert DataFlux dfPower Studio Profile Jobs to DataFlux Data 
Management Studio Profiles 

This topic is appropriate when you want to convert DataFlux dfPower Studio Profile jobs to 
DataFlux Data Management Studio profiles. Assume that you have identified a user-defined 
folder where you will save the DataFlux dfPower Studio Profile jobs after they have been 
converted, as described in the Overview. If you want to combine DataFlux dfPower Studio 
Profile jobs with their reports during the conversion, the following conditions must be met: 

• The current repository must have been migrated from DataFlux dfPower Studio. 

• Profile reports must have been saved to the DataFlux dfPower Studio repository 
before the repository was migrated. 

•  You must know the physical path to the profile jobs that correspond to the reports. 

This task is easier if you start by locating the user-defined folder where you will save the 
DataFlux dfPower Studio Profile jobs after they have been converted. 

Complete the following steps: 

1. Determine where you want to store the file and select the folder in the Folders directory. 
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2. Select Tools > Migrate Profile Jobs > Import Profile Jobs and Link Reports. 

 

3. In the resulting dialog box, double-check the Target location value. If this is not what is 
expected, be sure to change it, then click Add from filesystem. 
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4. Navigate to the folder where the Profile jobs that you want to convert are stored. Select 
one or more of these jobs, and then click Open. The jobs populate the Profile Job 
section of the wizard. 
 

 
 
If the current repository was migrated from DataFlux dfPower Studio, and profile reports 
were saved to that repository, then these reports are listed in the Linked report section 
of the wizard. The wizard does not display reports that have already been linked to 
migrated Profile jobs using the wizard. If you have made a mistake while linking the 
reports and only realized after saving the modifications, then you can select Tools > 
Migrate Profile Jobs > Unlink Profile Reports to undo these mistakes. 

5. When upgrading a dfPower Profile job, you can also link it to any reports that exist in the 
repository. To link a report to a Profile job, select the Profile job on the left, and then 
select the corresponding report on the right. The linked report should appear in the 
Linked Report column for the Profile job, as shown here. 
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6. Repeat as needed. 
 

 

7. When finished, click OK to convert the profile jobs that are listed in the wizard. The jobs 
are saved to the folder defined in the Target location. 
 

 

Since the report is linked to the DataFlux Sample Profile job, you can open that job to view 
the report. 
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Associate DataFlux Data Management Studio Profiles with DataFlux 
dfPower Studio Reports  

This topic is appropriate when you have already converted DataFlux dfPower Studio Profile 
jobs to DataFlux Data Management Studio profiles, but when the profile jobs were 
converted, the appropriate reports were not associated with the Profile jobs. The next step 
is to associate the reports. Assume that the following DataFlux Data Management Studio 
conditions have been met: 

• The current repository was migrated from DataFlux dfPower Studio. 

• Profile reports must have been saved to the DataFlux dfPower Studio repository 
before the repository was migrated. 

•  You know which DataFlux Data Management Studio profiles correspond to the 
DataFlux dfPower Studio reports. 

 

Perform the following steps: 

1. While in the Folders riser bar in DataFlux Data Management Studio, navigate to the 
folder that contains the Profile jobs. 

2. Select Tools > Migrate Profile Jobs > Import Profile Jobs and Link Reports 
from the main menu. A wizard opens. 

3. Click the Add from repository option. The Select Unlinked Profiles dialog box 
appears. 
 

 

4. Select one or more of these profiles, and then click Open. The selected jobs populate 
the Profile job section of the wizard. 
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5. To link a report to a profile, select the profile on the left, and then select the 
corresponding report on the right. The linked report should appear in the Linked 
Report column for the profile, as shown here. 
 

 

6. Repeat as needed. 

7. When finished, click OK to link the profile reports and save the profile definitions. The 
profiles are saved to the user-defined folder selected earlier in this process. 
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Unlink a DataFlux dfPower Studio Report from a DataFlux Data 
Management Studio Profile 

This topic is appropriate when you have already converted DataFlux dfPower Studio Profile 
jobs to DataFlux Data Management Studio profiles, and you linked a report to the Profile job 
in the process, but the link is incorrect. You want to remove the DataFlux dfPower Studio 
report that is incorrectly associated with a DataFlux Data Management Studio profile. 

1. Select Tools > Migrate Profile Jobs > Unlink Link Reports from the main menu. 
The Unlink Profile Reports dialog box appears. 
 

 

2. Click Add Profile. The Select Profile dialog box appears. 
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3. Select one or more profiles and click Open. The selected profiles are listed in the 
Unlink Profile Reports dialog box. 
 

 

4. Select one or more profiles from which to remove the linked report and click OK. 

5. The reports are unlinked from the profiles. 
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Post-Migration Tasks for Profile Jobs 
Profile jobs require additional post-migration tasks and might have restrictions based on the 
file type. For more information, see Other Changes 

Profile Jobs That Contain Macro Variables 

If DataFlux dfPower Studio Profile jobs were passing macros at time of execution, then 
several steps are necessary to make these Profile jobs work in the same manner when the 
jobs are upgraded. For this example, we assume that the Profile job has been upgraded and 
exists in the DataFlux repository. 

Perform the following steps: 

1. In DataFlux Data Management Studio, create a Process job and add a Profile 
(reference) node. 
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2. Configure the node to point to the Profile job. Use the user interface to navigate to the 
location. The result should look similar to this: 

 

3. Set two input variables called INPUT_PATH and INPUT_FILE. These are needed to 
accept the macros used by the Profile job. 
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4. Add two input variables to the Profile Job Reference node, click on the node and 
select the Inputs tab. Then add the two inputs and bind them to the input variables 
of the job. 

 

5. Enter in the name of the input. 
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6. Click OK. Now bind the value of the job variable to the input of the Process node. 
Highlight the INPUT_PATH and click Source Binding. 

 

7. Select the job variable INPUT_PATH: 

 

8. Click OK. 

 

9. Repeat the steps for INPUT_FILE. 
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10. Test the migration by copying the Profile job and the Process job to the server. To 
copy the Profile job, the Server’s repository must be registered in DataFlux Data 
Management Studio, select the Profile job and copy: 

 

11. Paste the job into the batch_jobs location on the server. Make sure that the job 
hierarchy is the same as where it was copied. In this case, there is one other folder 
under the DataFlux Data Management Studio repository batch_jobs called Profile. 
This folder must exist under the server’s repository batch_jobs location as well. 
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12. Next, move the Process job over. From the Data Management riser bar, select the 
server to Import the job to. 

 

13. Select the job and click Next. 
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14. Select the location and click Import. 

 

15. If this is successful, select Close. 
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16. Run the job to make sure everything works as expected. 

 

17. A Run Job dialog box appears. Provide the values and click Run. 

 

18. When the job is finished, you see something like this in the Run History tab. 

 

Note that if the Profile job is open in DataFlux Data Management Studio, the report is from 
the server job run. 
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Other Changes to Profile Jobs 

You cannot convert DataFlux dfPower Studio profile reports that are stored as files (.pfo 
files). You must either re-create the report for the relevant profile in DataFlux Data 
Management Studio or re-run the Profile job in DataFlux dfPower Studio and store the 
report in a DataFlux dfPower Studio repository. Then you can use the Import Profile Jobs 
and Link Reports wizard in DataFlux Data Management Studio to link a DataFlux dfPower 
Studio Profile job with the related report and combine the two in a DataFlux Data 
Management Studio profile. For more information, see the next section, Explorer Jobs. 

The way that Redundant Data Analysis is calculated has changed. In DataFlux dfPower 
Studio, you set up a Redundant Data Analysis profile for a primary field and add secondary 
fields that you want to compare to the primary field. The secondary fields were not 
compared to each other. In DataFlux Data Management Studio, you set up a Redundant 
Data Analysis profile and all fields that are added to the profile are compared to each other. 
Accordingly, after a Redundant Data Analysis profile job is converted, you must re-run the 
profile in DataFlux Data Management Studio to re-create the report. For more information, 
see the redundant analysis topic in the Profiles section of the latest version of DataFlux 
Data Management Studio online Help. 

Explorer Jobs 
You cannot convert Explorations that were created in DataFlux dfPower Studio. You must re-
create the Explorer jobs in DataFlux Data Management Studio. Refer to the Data 
Explorations section in the latest version of DataFlux Data Management Studio: User's 
Guide. Currently, the migration software moves DataFlux dfPower Studio Data Explorations 
into the Folders tree in DataFlux Data Management Studio but you cannot use these items 
in DataFlux Data Management Studio, however, so you can select and delete them from the 
Folders tree. 

Accelerators 
If any Accelerators are installed with DataFlux dfPower Studio, contact your DataFlux 
account representative to obtain a version compatible with the DataFlux software. 

Command Line Execution 
If you prefer running jobs from the command line with DataFlux dfPower Studio, then this 
has changed in DataFlux Data Management Studio. The archbatch.exe and ProfExec.exe are 
no longer used and jobs now run using dmpexec: 

usage: dmpexec [options] 
options: 
     -c <file>           read configuration from <file> 
     -j <file>            execute job in <file> 
     -l <file>           write log to <file> 
     -i <key>=<value>    set input <key> to <value> 
     -o <key>=<value>     set option <key> to <value> 
     -b <key>=<value>     set job option <key> to <value> 
     -a                    authenticate using Authentication Server 
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Here is an example of the command to run a Profile job in DataFlux Data Management 
Studio: 

> bin/dmpexec -l profileJob.log -j "<DM Studio install 
root>/etc/repositories/ProfileExec.djf" -i "REPORT_NAME=scriptedRun" -i 
"REPORT_DESCRIPTION=Server_Run" -i "JOB_ID=2" 

The JOB_ID is required to run profile jobs. Once the profile job is created, and then go to 
the Folders riser and select the profile job. 

 

In the Details pane, on the right, the Batch Run ID displays the value for the JOB_ID key. 

 

To run an upgraded Architect job in DataFlux Data Management Studio where the job can 
be a Process (with the extension .djf) or Data job (.ddf), type: 

> bin/dmpexec -c "cmdLine.cfg" -l "dmpJob.log" –j "path/to/architect.ddf" 

If the job needs to run with a user’s credentials, the credentials are stored in a configuration 
file, which would look something like this: 

base/auth_server_loc  
=iom://servername.domain.com:21030;protocol=bridge;user=userid,pass=password 

Then passed in on the command line with the following options: 

> bin/dmpexec -a -c "dmpexec_auth.cfg" -l "dmpJob.log" –j 
"path/to/architect.ddf" 

Note: DataFlux Batch Schedules from DataFlux dfPower Studio do not 
migrate to DataFlux Data Management Studio. The DataFlux Batch Scheduler 
application does not exist in DataFlux Data Management Studio. To schedule 
jobs in DataFlux Data Management Studio, you need to write your own 
scripts. 
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SAS Data Integration Studio 
Customers with SAS 9.2 that have the SAS Enterprise Data Integration Server and SAS 
Data Integration Server bundles must migrate to SAS 9.3* or SAS 9.4* first. In that 
process, the system is upgraded to DataFlux software. You should understand the following 
before migrating to the latest release of the platform. 

• The DataFlux IS Job transformation is now called the DataFlux Batch Job 
Transformation. The DataFlux IS Service transformation is now called the DataFlux 
Data Service transformation. For other changes related to these transformations, see 
Working with Data Quality Transformations in the SAS Data Integration Studio: User's 
Guide. 

User Action Required for Migrated Jobs with the Create Match Code 
Transformation 

If jobs that include the Create Match Code transformation do not run successfully after 
migration, verify that the appropriate Quality Knowledge Base (QKB) location value 
(DQSETUPLOC value) is specified on the global options window for SAS Data Integration 
Studio. To verify the DQSETUPLOC value, select Tools > Options from the menu bar, click 
the Data Quality tab, and then verify that the appropriate value is specified in the DQ 
Setup Location field. 

User Action Required for Migrated Jobs with the Apply Lookup 
Standardization Transformation 

Migration to SAS v. 9.3 When the QKB Is Different on the Target System 

If you are migrating from SAS v. 9.1.3 or SAS v. 9.2 to SAS v. 9.3, and the target system 
has a different QKB than you had on the source system, then user action is required in 
order for a job with the Apply Lookup Standardization transformation to work. You must 
open each affected job and replace the migrated Apply Lookup Standardization 
transformation with a new (4.3) Apply Lookup Standardization transformation. Then you 
must restore the mappings in each job. 

Migration to SAS v. 9.3 When the QKB Is the Same on the Target System 

If you are migrating from SAS v. 9.2 to SAS v. 9.3, and the target system has the same 
QKB that you had on the source system, then no user action is required in order for a job 
with the Apply Lookup Standardization transformation to work. 

If you are migrating from SAS v. 9.1.3 to SAS v. 9.3, and the target system has the same 
QKB that you had on the source system, then user action is required in order for a job with 
the Apply Lookup Standardization transformation to work. 

You can take one of the following actions: 

• Open each affected job and replace the migrated Apply Lookup Standardization 
transformation with a new (4.3) Apply Lookup Standardization transformation. You 
must restore the mappings in each job. After replacing the transformation, the Control 
Flow of the transformation in the job is out of order. Use the Details panel to restore 
Control Flow. 



 
DataFlux Migration Guide 93 
 

• Alternatively, you could return to your old SAS Data Integration Studio environment, 
export the original Apply Lookup Standardization jobs to the SAS v. 9.1.3 package 
format, and then use the Import SAS Package wizard in SAS Data Integration Studio 
v. 4.3 to convert and register these jobs on your metadata server. 

The following additional steps are required in order for the export SAS Package method to 
work: 

1. (Optional) In SAS Data Integration Studio v. 4.3, if you are not using the migrated 
jobs that include the Apply Lookup Standardization transformation, delete them. 
Otherwise, you must manage multiple copies of the same metadata objects when you 
import the same jobs as a SAS Package. 

2. In the previous release of SAS Data Integration Studio, create a package of jobs that 
uses the same scheme repository type in the Apply Lookup Standardization. Create 
one package for the BFD scheme type and a separate package for the NOBFD scheme 
type. 

3. In SAS Data Integration Studio v. 4.3, verify that the default DQ Setup Location is 
correct, and that the default Scheme Repository Type matches the type (BFD or 
NOBFD) for the package of jobs that you are importing. 

Since dfPower jobs change extensions for DataFlux Data Management Studio based jobs, 
users must edit the SAS Data Integration Studio jobs. To do this, in Data Integration Studio 
open up a job that uses a DataFlux service or a Profile job. 

 

Open the properties of the node. 
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For Data Services click the Data Service tab. In the Servers and services grouping, click 
the drop-down list and select the new service to run. 

 

The steps are the same for a Profile job except that the tab is called Job and the drop-down 
list is also called Job. 

 

For a final change, in SAS Data Integration Studio, you need to register the path of where 
DataFlux Data Management Studio is located. Open SAS Data Integration Studio and go to 
Tools > Options > Data Quality. 
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For the DataFlux Installation Folder field value, navigate to the installation root (for 
example, C:\Program Files\DataFlux\DMStudio\2.2) and save the location. 

 

Click OK and then re-start SAS Data Integration Studio. 

Other 
Note that Match jobs (.mdf) are not migrated. You can still view the output files (.mre) from 
DataFlux Data Management Studio but the .mdf files can no longer be generated. 

Items found in the Business Rule Manager interface come over when the repository is 
migrated. By default, all migrated Rules and Tasks show up in the DataFlux Data 
Management Studio Folders riser under the Shared Data folder. You cannot migrate a single 
rule from a dfPower Repository to a DataFlux repository. If a Task, Rule, Custom Metric, and 
so on, is re-created, then you should check the original location to make sure it is 
referencing the correct item. 

Best Practice: You should migrate the repository and make sure things are working 
correctly with existing data before doing anything new in the DataFlux Data Management 
Studio. 
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DataFlux Integration Server 8.1/8.2 to 
DataFlux Data Management Server 
This section is for those users currently running a DataFlux Data Integration Server v. 8.* 
stand-alone or as part of a SAS v. 9.2 deployment. For SAS 9.2 customers, the DataFlux 
Data Management Server is automatically installed and a server definition is created in the 
SAS Metadata Repository. Users then need to take manual steps to migrate jobs and other 
repository content in order to get them to work with DataFlux Data Management Server. If 
you are installing SAS 9.3 as well as DataFlux software, use this section to move directly 
from DataFlux Data Integration Server v. 8.* to DataFlux Data Management Server. 

• Configurations 

• Data Quality Functions 

• Reference Sources 

• Data Connections - Windows 

• Data Connections - UNIX 

• Repositories 

• Architect Jobs 

• Profile Jobs 

• Accelerators 

• Security 

• Secure Socket Layer 

• Command Line Execution 

• SAS Management Console 

• SAS Data Quality Server 
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Configurations 
You need to copy the values that are in the DataFlux Data Integration Server configuration 
files to the DataFlux Data Management Server configuration files. The table below maps the 
settings between them.  

The best way to use the table is to look at the DataFlux Data Integration Server dfexec.cfg 
file, find the configuration from the file in the "Data Integration Server Setting" column, look 
to the left to see the DataFlux Data Management Server equivalent setting found in the first 
column and put the value in the file identified in column two. For example, in the dfexec.cfg 
file, we have the following: 

 

To find the equivalent setting in DataFlux Data Management Server, look in the "Data 
Integration Server Setting" column to find "server read timeout". 

 

From there we can tell that the DataFlux Data Management Server equivalent setting is 
"DMSERVER/SOAP/RDWR_TIMEOUT" (column one) and that the value lives in dmserver.cfg 
(column two). Open the dmserver.cfg file and locate "DMSERVER/SOAP/RDWR_TIMEOUT" 
by doing a find (CTRL+F) and looking for the configuration, which is 
DMSERVER/SOAP/LISTEN_PORT. In this case, the setting is not in the default configuration 
file, so we need to add it. 

 

Several specific differences between the configuration files include the following: 

• Numeric values in DataFlux Data Management Server need to be written out. Values 
in DataFlux Data Integration Server could be 10m, which represents 10 million. In 
DataFlux Data Management Server, this would need to be written as 10000000. 
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• DataFlux Data Management Server does not require configuration values to be 
enclosed in single quotation marks 

• Double quotation marks are not special in DataFlux Data Management Server 
configuration files. 

• To escape characters (", =, white space, and so on) in DataFlux Data Management 
Server configuration files enclose them in single quotation marks. 

 

DataFlux Data Management 
Server Setting 

DataFlux Data 
Management 
Server File 

DataFlux Data 
Integration Server 

Setting 

DIS 
File/Registry 

DATASVC/IGNORE_DECLARED_V
ARS 

service.cfg -- -- 

DATASVC/THREAD_STACK_SIZE service.cfg -- -- 
DMSERVER/CHILD/LISTEN_HOS
T 

dmserver.cfg server child listen (dfexec.cfg) 

DMSERVER/CHILD/LISTEN_POR
T 

dmserver.cfg server child listen (dfexec.cfg) 

DMSERVER/IPACC/ALL_REQUES
TS 

dmserver.cfg restrict general 
access 

(dfexec.cfg) 

DMSERVER/IPACC/POST_DELET
E 

dmserver.cfg restrict post/delete 
access 

(dfexec.cfg) 

DMSERVER/JOBS_MAX_NUM dmserver.cfg dfexec max num (dfexec.cfg) 
DMSERVER/JOBS_NO_STATE dmserver.cfg     
DMSERVER/JOBS_ROOT_PATH dmserver.cfg arch svc path 

arch job path 
prof job path  

(dfexec.cfg) 

DMSERVER/LOG_CHUNK_SIZE dmserver.cfg server send log 
chunk size 

(dfexec.cfg) 

DMSERVER/NO_WORK_SUBDIR
S 

dmserver.cfg     

DMSERVER/SECURE dmserver.cfg enable security (dfexec.cfg) 
DMSERVER/SECURE/DEFAULT_A
CE_PUBLIC 

dmserver.cfg     

DMSERVER/SECURE/DEFAULT_A
CE_USERS 

dmserver.cfg     

DMSERVER/SECURE/GRP_ADMI
N 

dmserver.cfg     

DMSERVER/SECURE/GRP_ALLO
W 

dmserver.cfg     

DMSERVER/SECURE/GRP_DENY dmserver.cfg     
DMSERVER/SOAP/CONNS_BACK
LOG 

dmserver.cfg PRIV connections 
backlog 

(dfexec.cfg) 

DMSERVER/SOAP/DATA_SVC/JO
B_COUNT_MAX 

dmserver.cfg -- -- 

DMSERVER/SOAP/DATA_SVC/JO dmserver.cfg -- -- 
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DataFlux Data Management 
Server Setting 

DataFlux Data 
Management 
Server File 

DataFlux Data 
Integration Server 

Setting 

DIS 
File/Registry 

B_COUNT_MIN 
DMSERVER/SOAP/DATA_SVC/M
AX_ERRS 

dmserver.cfg dfsvc max errs (dfexec.cfg) 

DMSERVER/SOAP/DATA_SVC/M
AX_NUM 

dmserver.cfg dfsvc max num (dfexec.cfg) 

DMSERVER/SOAP/DATA_SVC/M
AX_REQUESTS 

dmserver.cfg dfsvc max requests (dfexec.cfg) 

DMSERVER/SOAP/DATA_SVC/M
AX_RUNTIME 

dmserver.cfg -- -- 

DMSERVER/SOAP/DATA_SVC/PR
ELOAD 

dmserver.cfg dfsvc preload (dfexec.cfg) 

DMSERVER/SOAP/DATA_SVC/PR
ELOAD_ALL 

dmserver.cfg dfsvc preload all (dfexec.cfg) 

DMSERVER/SOAP/DATA_SVC/QU
EUE 

dmserver.cfg -- -- 

DMSERVER/SOAP/IGNORE_NS dmserver.cfg -- -- 
DMSERVER/SOAP/LOG_PACKETS dmserver.cfg PRIV log packets (dfexec.cfg) 
DMSERVER/SOAP/LISTEN_HOST dmserver.cfg -- -- 
DMSERVER/SOAP/LISTEN_PORT dmserver.cfg server listen port (dfexec.cfg) 
DMSERVER/SOAP/PROC_SVC/M
AX_NUM 

dmserver.cfg -- -- 

DMSERVER/SOAP/RDWR_TIMEO
UT 

dmserver.cfg server read timeout 
Read timeout  

(dfexec.cfg) 
(dfexec.cfg) 

DMSERVER/SOAP/RETURN_NULL
S 

dmserver.cfg     

DMSERVER/SOAP/SSL dmserver.cfg soap over ssl (dfexec.cfg) 
DMSERVER/SOAP/SSL/CA_CERT
_FILE 

dmserver.cfg soap ssl CA cert file (dfexec.cfg) 

DMSERVER/SOAP/SSL/CA_CERT
_PATH 

dmserver.cfg soap ssl CA cert 
path 

(dfexec.cfg) 

DMSERVER/SOAP/SSL/KEY_FILE dmserver.cfg soap ssl key file (dfexec.cfg) 
DMSERVER/SOAP/SSL/KEY_PAS
SWD 

dmserver.cfg soap ssl key 
password 

(dfexec.cfg) 

DMSERVER/THREADS/COUNT_M
AX 

dmserver.cfg svr max threads (dfexec.cfg) 

DMSERVER/THREADS/IDLE_MAX dmserver.cfg svr max idle threads (dfexec.cfg) 
DMSERVER/THREADS/IDLE_TIM
EOUT 

dmserver.cfg svr idle thread 
timeout 

(dfexec.cfg) 

DMSERVER/WLP/DATA_SVC/MA
X_NUM 

dmserver.cfg dfwsvc max num (dfexec.cfg) 

DMSERVER/WLP/LISTEN_HOST dmserver.cfg server wlp listen (dfexec.cfg) 
DMSERVER/WLP/LISTEN_PORT dmserver.cfg server wlp listen (dfexec.cfg) 
DMSERVER/WORK_ROOT_PATH dmserver.cfg Job io path (dfexec.cfg) 
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DataFlux Data Management 
Server Setting 

DataFlux Data 
Management 
Server File 

DataFlux Data 
Integration Server 

Setting 

DIS 
File/Registry 

Working path 
WorkingPath  

(dfexec.cfg) 
HKEY_LOCAL_MA
CHINE\SOFTWAR
E\Wow6432Node\
DataFlux 
Corporation\dfPo
wer 
Studio\8.1\DIS 
Environment  

Configuration Values from DataFlux Data Integration Server to DataFlux Data Management Server 

 

The following table represents a list of configurations that were in the dfexec.cfg file, which 
are now in the app.cfg file. 

DataFlux Data Management 
Server v. 2.2 Setting 

DataFlux Data 
Management 
Server File 

DataFlux Data 
Integration Server 

Setting 
DIS File/Registry 

BASE/PRIMARY_LICENSE_LOC app.cfg License HKEY_LOCAL_MACHIN
E\SOFTWARE\Wow643
2Node\DataFlux 
Corporation\dfPower 
Studio\8.1\DIS 
Environment 

DAC/SAVEDCONNSYSTEM app.cfg savedconnectiondir HKEY_LOCAL_MACHIN
E\SOFTWARE\Wow643
2Node\DataFlux 
Corporation\dac 

DFCLIENT/CFG app.cfg dfclient config (dfexec.cfg) 
BASE/EMAILCMD app.cfg mail command (dfexec.cfg) 
    Cluster memory (dfexec.cfg) 
VERIFY/USEDPV app.cfg Enable dpv (dfexec.cfg) 
VERIFY/USERDI app.cfg Enable rdi (dfexec.cfg) 
PROF/PER_TABLE_BYTES app.cfg Fd table memory (dfexec.cfg) 
QKB/PATH app.cfg Qkb root (dfexec.cfg) 
VERIFY/USPS app.cfg Usps db (dfexec.cfg) 
VERIFY/CACHESIZE app.cfg Verify cache (dfexec.cfg) 

Configuration Values Previously in the dfexec.cfg File That Are Now in the app.cfg File 
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If any Accelerators are installed with your Integration Server installation, it is not 
recommended that the macros associated with them be moved over. You should obtain the 
proper version of the Accelerator that works with the DataFlux software. This means that no 
macros should be moved over when looking in architect.cfg or dfexec.cfg, if they contain the 
following prefixes: 

• MDI_ 

• MDC_ 

• SA_ 

• ACDQ_ 

• CDC_ 

• CDA_ 

• WLC_ 

• MDM_ 

Any remaining macros in architect.cfg or dfexec.cfg that are not in the DataFlux Data 
Integration Server to the DataFlux Data Management Server table or are not Accelerator 
macros are probably user-defined macros. Move these remaining macros to a new file in the 
<DM Server install root>/etc/macros/ directory. Do not place them in any of the DataFlux 
Data Management Server specific configuration files. 

Note: If you see a macro that is not a user defined and believe it to be a 
DataFlux setting, please contact SAS technical support. 

Here is an example. In the DataFlux Data Integration Server there is a macro called 
OUTPUT_PATH that we need to move over. 
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Go to Windows Explorer and navigate to the install root for DataFlux Data Management 
Server, in this case it is the default "C:\Program Files\DataFlux\DMSserver\2.2". 

 

Go into the etc\macros directory. 

 

Create a new text file called 81macros.cfg. More than likely you need to confirm the 
changing of the extension from .txt to .cfg. If so, please say yes. 
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Open up 81macros.cfg and copy the value from architect.cfg or dfexec.cfg 

 

Repeat these for each user-defined macro. It is recommended that all DataFlux Data 
Integration Server macros be put in the same file initially. 

It is a best practice to make sure that the following two configurations in dmserver.cfg are 
set with valid ports: 

• DMSERVER/SOAP/LISTEN_PORT 

• DMSERVER/WLP/LISTEN_PORT 

Note: If these are not set, it could lead to issues if there is an Integration 
Server or multiple data management servers installed on the same host. 

 

 

 

 

If users want to use single page dfPower real-time services as part of their data 
management deployment, then the following needs to be added to the <DM Server install 
root>/etc/service.cfg file. 

DATASVC/IGNORE_DECLARED_VARS = yes 

Data Quality Functions 
If as part of the migration a new Quality Knowledge Base (QKB) is being used, it is a best 
practice to regenerate any static data quality pieces such as match codes. The reason for 
this is that changes in the QKB could result in a slightly different match code being 
generated. 

DataFlux Data Management Studio 2.3 and later: 

• DMSERVER/WLP/LISTEN_PORT no longer needs to be set by default. 
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For users that are on dfPower 8.2 that are not changing QKBs as part of the migration, see 
Migrating from DataFlux dfPower Studio v. 8.1/8.2 to DataFlux Data Management Studio v. 
2.2 for more information about how to configure DataFlux software so that it uses data 
quality functions as they were in dfPower 8.2. It is strongly recommended to do this only if 
it is really needed. 

Reference Sources 
When the configurations for the Integration Server are brought over, this should take care 
of the registration of the data packs for US address data, Canadian address data, US 
geocode and phone data as well as the world data. No extra steps should be needed other 
than to verify that the locations have been configured correctly. 

Data Connections - Windows 
Assuming that DataFlux Data Management Studio is being installed on the same box that 
the previous version of Integration Server was, no extra work is required to migrate over 
any ODBC connections. If DataFlux Data Management Server is being installed on a new 
box, then manually migrate the ODBC connections that are defined in the ODBC 
Administrator. 

ODBC data connections that are defined on the box are automatically upgraded to the latest 
version of the DataFlux ODBC drivers. This means that both DataFlux dfPower and DataFlux 
Data Management Studio use the same version of ODBC drivers. 

If a 32-bit version of Integration Server was installed on a 64-bit box, and if the 64-bit 
version of DataFlux Data Management Server is installed on the same box, then the ODBC 
DSNs must be re-created through the 64-bit version of the ODBC Data Source. The best 
way to do this copying is to open the 32-bit ODBC Administrator through DataFlux dfPower 
Studio (assuming that this was installed on the box in order to create the connections 
originally) or the dfConnection Manager. 
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Then open the 64-bit ODBC Administrator using the Control Panel. 

 

 

There is no way to distinguish which version is 32-bit or 64-bit, so you need to keep it 
organized. In the above picture, the 32-bit is on the left and the 64-bit is on the right. From 
this point forward, create the DSNs in the 64-bit ODBC Administrator by creating new and 
then copying the values and settings of the 32-bit configurations. 

Move over any saved credential files that have been stored. These can be found in <DIS 
install root>\etc\dfdac\ and should be copied to <DM Server install root>\etc\dsn\. 

The user needs to move over any saved credential files that they have stored. The dfPower 
saved connection path can be found in the registry under 
"HKEY_LOCAL_MACHINE\SOFTWARE\\DataFlux Corporation\dac\savedconnectiondir" or 
"HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\DataFlux 
Corporation\dac\savedconnectiondir" key. If it is not there, then the saved connections 
should be in %APPDATA%\dfdac\mydatasources. These saved credential files should be 
copied to <DM Server install root>/etc/dsn/. 
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Data Connections - UNIX 
If DataFlux Data Management Server is being installed on the same box as a previous 
Integration Server installation, then it is recommended that the ODBC connections already 
defined in the ODBC.ini file for the Integration Server installation be re-created in the 
DataFlux Data Management Server’s ODBC.ini file. The reason for doing this is so that the 
supported ODBC drivers are used. ODBC settings are per application and are not set system 
wide. The dfdbconf utility located in <DM Server install root>/bin should be used to re-
create the DSNs. 

Once the connections are re-created, the next step is to bring over any saved credentials. 
On UNIX servers, if dfdbview was used to save the credentials, these are found in the user’s 
home directory under the .dfpower directory. If a DataFlux Data Management Server is 
being installed under the same user ID as the Integration Server, then the DataFlux Data 
Management Server uses those credentials in the .dfpower directory. If a different user is 
doing the installation or the server is being installed on a different box, then these settings 
should be copied over. 

Repositories 
With the Integration Server, you could connect to multiple dfPower repositories (called data 
storages in DataFlux Data Management Studio or Server) at a time. This is no longer the 
case with DataFlux Data Management Server. It supports connecting to only one data 
storage portion of a repository at a time. If separate versions of the dfPower repository are 
required, then multiple versions of the DataFlux Data Management Server are required. This 
type of configuration is supported on UNIX, but not on Windows. 

From the "etc/profrepos.cfg" file, identify the DSN that is the data storage part for the 
DataFlux Data Management Server. If dfPower repositories need to be merged, this should 
be completed before upgrading. 

In order to set up the repository, you must perform the following tasks 

• Create a Copy of the Repository 

• Repository Post-Creation Tasks 
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Create a Copy of the Repository 

You need to create a copy of a repository that the Integration Server is using, and then 
upgrade it so that it can be used by the DataFlux Data Management Server. The assumption 
is that all Business Rules and other repository objects have been moved into the one 
repository that you are upgrading. 

For this example, start with the Database Connections screen: 

 

Note that the repository screen shows the registered "81 Server" repository: 
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Perform the following steps: 

1. Create a second DSN that holds the copy. In this example, this is the "81 Server 
Copy". 

2. Copy the "81 Server" repository to the "81 Server Copy" repository as shown below. 

 

 

If this were a file-based repository, the same action would be used, but the File 
option would be selected instead of the Database option. 

Note: It is highly recommended to use the Table prefix option to identify that this 
is a copy. Even if the recommendation of putting the copy in a different schema were 
used, this would be another way to identify that this is not an original repository. 
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3. Upgrade the copy in DataFlux Data Management Studio. If the DSN does not exist on 
the machine that has DataFlux Data Management Studio, go ahead and create it. 

 

4. Create the repository definition in DataFlux Data Management Studio. Notice that we 
are using the same values that we used when we created the copy in dfPower: 

 

Note that the "Folder" configuration is left blank in the DataFlux Data Management 
Studio configuration. This is done on purpose. When we save the configuration, DataFlux 
Data Management Studio informs us that the repository needs to be upgraded. This 
indicates that the system has recognized that we have an older version and it needs to 
be updated so that DataFlux Data Management Studio can use it.  

5. Select OK. 
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6. As expected, an error message indicates that the repository needs to be upgraded. 
Select OK. 

 

7. Right-click on the repository and choose Upgrade. 

 

8. When prompted to confirm the upgrade, select Yes. 

 

9. The upgrade process kicks off. At the end of it, there should be a confirmation that 
the upgrade completed successfully. Select Close. 
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10. When the upgrade is done, connect to the repository. Wait for the indication in the 
repository screen that it connected. 

 

 

Repository Post-Creation Tasks 

Once the repository is created, you need to do two things: 

• Copy the repository configuration file to the server 

• Copy or save credential files to the server. 

Regardless whether the server is UNIX or Windows based, the repository configuration file 
(.rcf) is saved in the <DM Server root>/etc/repositories directory. The DataFlux Data 
Management Studio RCF file needs to be copied to this location.  

Perform the following steps: 

1. Rename the default RCF file that came with DataFlux Data Management Server. 

 

2. Find the Studio RCF file and copy this to the Server. If you followed the screenshots, 
the repository was configured as being private. This means that the RCF file can be 
found by going to %APPDATA%\DataFlux\DataManagement\2.2\repositories. 
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If it is not in this location, then look in <DM Studio root>\etc\repositories and copy 
the "81 Server Upgrade.rcf" file to the server.  

In the following display, FileZilla is used to SFTP the file over to the Server. 

 

3. Copy the saved credentials on your DataFlux Data Management Studio box to the 
DataFlux Data Management Server machine. The saved credentials are in the 
%APPDATA%\DataFlux\dac\9.1 directory; copy them to the <DM Server 
root>/etc/dsn directory. For DataFlux Data Management Studio 2.3 and later 
versions, the saved credentials are in the 
%APPDATA%\DataFlux\DMStudio\<instance> directory. 
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4. In the RCF file, locate the DSN name that you need to create on the server. 

 

5. Create the DSN on the server (assuming that you know what data source this should 
be connecting to). 
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6. View the contents of the 8.1 Server. The file storage location of the DataFlux Data 
Management Server is always <DM Server Install root>\var\. In this example, only 
two directories need to be moved over. 

 

7. Copy the contents of <DIS root>/var/dis_arch_job into the <DM Server 
root>/var/batch_jobs directory.  

8. Copy the contents of the <DIS_root>/var/dis_arch_svc into the <DM Server 
root>/var/data_services directory.  

CAUTION! Do NOT copy anything from the dis_prof_job directory. 

Profile jobs need to be migrated through DataFlux Data Management Studio. 

If the repository that the server uses is a file-based repository, then the *.rps file needs to 
be moved over to the server. This should be copied to <DM Server install 
root>/var/repositories. Be sure to double check the <DM Server install 
root>/etc/repositories/*.rcf file to make sure it is using the file-based repository. 

Architect jobs continue to run on a DataFlux Data Management Server with no conversion 
needed, but it is highly recommended that jobs be converted using DataFlux Data 
Management Studio, tested and then uploaded to the Server. This enables you to take 
advantage of new features and functionality that the DataFlux software offers. The one 
caveat to this is if there are multi-page jobs that pass macro values between them. These 
jobs need to be upgraded and deployed to the server for them to run correctly. 

If users want to use single page dfPower real-time services as part of their data 
management deployment, add the following to the <DM Server install root>/etc/service.cfg 
file. 

DATASVC/IGNORE_DECLARED_VARS = yes 
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Architect Jobs 
Architect jobs can be moved over from the Integration Server work area and run with no 
changes in DataFlux Data Management Server. 

It is highly recommended that jobs be converted using DataFlux Data Management Studio, 
tested and then uploaded to the Server. This enables you to take advantage of new features 
and functionality that the DataFlux software offers. 

Profile Jobs 
Profile jobs need to be imported through DataFlux Data Management Studio before they can 
be run on DataFlux Data Management Server. 

If the job is imported into a repository that the Server is not connected to, the profile must 
be copied to the Server’s repository. Once again, this is done through DataFlux Data 
Management Studio. It must have a connection to the data storage that the server is using. 
Once the connection is made, Profile jobs can be copied using the Folders riser. 

In DataFlux Data Management Studio, the Lin64 Repo is a DataFlux Data Management 
Server repository on a Linux 64 box. Notice that it does not have the Profile job, 
dfSample_profile on it. 

 

We want to copy this Profile job from local repository to this one. To do this we select the 
job, right-click and select Copy. 
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Select the batch_jobs folder in the Lin64 repository, right-click, and select Paste. This adds 
the Profile job and make it available to run via the Data Management Server Manager 
interface in DataFlux Data Management Studio. 

 

Accelerators 
If any Accelerators have been installed with the Integration Server, contact your account 
representative to get the correct version that is compatible with the DataFlux software. 

Security 
Before setting up security, refer to the DataFlux Secure: Administrator’s Guide. 

 

If security was being used before with DataFlux Integration Server, all security settings that 
you used on that server need to be re-created from scratch in DataFlux Data Management 
Server. The model used in the DataFlux software has changed and requires you to reset all 
user permissions and re-create any Access Control List settings that you might have had for 
individual jobs. 

Security for DataFlux Data Management Server 2.5 or Earlier 

Install and configure the DataFlux Authentication Server first. Users and groups need to be 
defined in the DataFlux Authentication Server in order for them to be given privileges on the 
DataFlux Data Management Server. The DataFlux Authentication Server supports 
integration with Active Directory, LDAP, and PAM. 

DataFlux Data Management Studio 2.7 and later: 

The DataFlux Data Management Server is automatically configured to use the SAS Metadata 
Repository. The BASE/AUTH_SERVER_LOC would have the location of the SAS Metadata 
Repository and the DMSERVER/SECURE/GRP_ADMIN is set to SASAdministrators.  
 
If a user was using Authentication Server before and starts using the SAS Metadata Repository, 
any authorizations that they created before need to be re-created. See the Update Security Files 
after Exporting Users and Groups section for more information. 
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Once the DataFlux Authentication Server is installed, configured and users are added, the 
DataFlux Data Management Server needs to be configured as well. The following settings 
should exist in the dmserver.cfg file: 

DMSERVER/SECURE = yes 
DMSERVER/SECURE/GRP_ADMIN = <name of group defined in  
Authentication Server> 
BASE/AUTH_SERVER_LOC = <Location of where the  
Authentication Server is installed> 

The GRP_ADMIN setting can be any group that is in the DataFlux Authentication Server. It is 
recommended that a group called DMS_ADMINS be used. 

Security for DataFlux Data Manager Server 2.7 or Later 

The SAS Metadata Repository should be installed and configured first. Users and groups 
need to be defined in the SAS Metadata Repository in order for them to be given privileges 
on the DataFlux Data Management Server. 

DataFlux Data Management Server should already be configured to connect to the SAS 
Metadata Repository. The following settings should exist in the dmserver.cfg: 

DMSERVER/SECURE = yes 
DMSERVER/SECURE/GRP_ADMIN = SASAdministrators 
BASE/AUTH_SERVER_LOC = <Location of where the SAS Metadata Repository is 
installed> 

Common Security Steps 

Once the dmserver.cfg file is configured correctly, restart the DataFlux Data Management 
Server if any edits were made and connect to the server via the Data Management Server 
Manager interface in DataFlux Data Management Studio. Log on using any user in the group 
defined by DMSERVER/SECURE/GRP_ADMIN. Once logged in, the user needs to assign 
server level access and then job level access. The default is to deny everyone any privilege 
except for those in the admin group. 

First, provide Server level authorization. After logging in, select the server and then select 
the Security tab. 
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Select Add to add users and groups and give them the needed permissions 

 

Next, assign job rights by selecting one or multiple jobs, right clicking, and selecting 
Permissions. 

 

This brings up a dialog box that enable you to set the owner if it needs to be different as 
well as set permissions for users or groups. 

 



 
120 DataFlux Migration Guide 
 

If both steps are not followed, then users are unable to run jobs as they would expect to. 

Note: This is different behavior than you experienced previously with 
Integration Server security. In Integration Server, once the Execute privilege 
was provided at the server level, the default was to grant all users the right to 
run the job and only explicitly deny users. For DataFlux Data Management 
Server, once the Execute privilege is provided, users must explicitly be 
allowed to run specific jobs. 

 

Secure Socket Layer 
Secure Socket Layer (SSL) configuration still exists in the DataFlux Data Management 
Server. This setup and configuration should be handled when moving migrations. Support 
for LDAP or Active Directory has moved to the DataFlux Authentication Server. For both 
configurations, please refer to the DataFlux Data Management Server: Administrator's Guide 
and the DataFlux Authentication Server: Administrator’s Guide for detailed configuration 
steps. 

Command Line Execution 
The Integration Server Command line used these arguments: 

usage: dfexec [OPTIONS] jobfile [jobfile...] 
general options: 
     -i                    interactive mode 
     -q                    quiet (no status messages) 
     -cfg FILE             use alternate configuration file 
     -log FILE             use FILE for logging output 
     --version             display version information 
     --help                display this message 
additional options for Architect jobs: 
     -w                    write default target's output to terminal 
     -fs SEP               use SEP as field separator for terminal output 
     -m MODE               execution mode: d(efault), s(erial), p(arallel) 
additional options for Profile jobs: 
     -o OUTPUT             output file or repository name; file names must 
                           end with .pfo (defaults to profile.pfo) 
     -n NAME                report name (defaults to current date and time) 
     -a                    append to existing report 
     -desc DESCRIPTION      optional job description 

The batch jobs execution utility has the following command line arguments: 

usage: dmpexec [options] 
options: 
     -c <file>             read configuration from <file> 
     -j <file>             execute job in <file> 
     -l <file>             write log to <file> 
     -i <key>=<value>      set input <key> to <value> 
     -o <key>=<value>      set option <key> to <value> 
     -b <key>=<value>      set job option <key> to <value> 
     -a                    authenticate using Authentication Server 
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If we had scripts setup on the Integration Server host to run a profile and architect job, it 
might look like the following: 

> bin/dfexec –log profileJob.log –o Script_Run.pfo –n scriptedRun profile.pfi 

> bin/dfexec –log disJob.log –cfg cmdLine.cfg architect.dmc 

To run the upgraded jobs on DataFlux Data Management Server, the commands would look 
like this: 

> bin/dmpexec -l profileJob.log -j "<DM Server install 
root>/etc/repositories/ProfileExec.djf" -i "REPORT_NAME=scriptedRun" -i 
"REPORT_DESCRIPTION=Server_Run" -i "JOB_ID=2" 

JOB_ID is required to run profile jobs. Once the profile has been copied to the repository 
that the server reads from, go to the Folders riser and select the profile job. 

 

If the Profile job is inside a Process job, and assuming that the Profile job is using macros 
that need to be passed in at run time, use the following: 

> bin/dmpexec -c "cmdLine.cfg" -l "dmpJob.log" -j "path/to/process.djf" -i 
"INPUT_PATH=path/to/input" -i "INPUT_FILE=file.txt" 

To run the upgraded Architect job in the DataFlux Data Management Server, use the 
following command: 

> bin/dmpexec -c "cmdLine.cfg" -l "dmpJob.log" –j "path/to/architect.ddf" 

If the job needs to run with a user’s credentials, the credentials would be stored in a 
configuration file, which would contain something like the following: 

base/auth_server_loc 
=iom://servername.domain.com:21030;protocol=bridge;user=userid,pass=password 

Then passed in on the command line with the following options: 

> bin/dmpexec -a -c "dmpexec_auth.cfg" -l "dmpJob.log" –j "path/to/architect.ddf" 
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SAS Management Console 
When moving from SAS 9.2 to SAS 9.3, a DataFlux Data Management Server entry is 
created in metadata. This entry might need to be renamed and a new DataFlux Data 
Management Server entry created with the same name. This allows Data Integration Studio 
jobs to continue to run without having to be updated to handle the change in servers. 
Before following the next set of steps, look at the properties of the defined DataFlux Data 
Management Server and validate that the TCP/IP connection is pointing to the correct host 
and port. If so, no changes are needed. If they are not, please follow the next set of steps 
to define a DataFlux Data Management Server that is pointing to the correct host and port. 

1. Open SAS Management Console and rename the existing DataFlux Data Management 
Server entry. 

 

For the example, append " – original" to the end of the name. 
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2. Create a new server entry using the same name from the original server entry. 

 

3. The New Server Wizard opens. Select Http Server and then select Next. 

 

4. Give it the same name that was used for the original entry. In this example, name = 
"DataFlux Data Management Server - rdcesx09020". 
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5. In the next dialog box, enter or verify that the following information is entered: 

• For DataFlux Data Management Server 2.2: Software Version = 2.2 

For DataFlux Data Management Server 2.3: Software Version = 2.3 

For DataFlux Data Management Server 2.4: Software Version = 2.4 

For DataFlux Data Management Server 2.5: Software Version = 2.5 

For DataFlux Data Management Server 2.6: Software Version = 2.6 

For DataFlux Data Management Server 2.7: Software Version = 2.7 

• Vendor = DataFlux Corporation 

• Base Path(s) = / 

• Application Server Type = DataFlux Data Management Server 

 

6. Select the New button. In the resulting dialog box, select OK. 

7. Select Next. 

 



 
DataFlux Migration Guide 125 
 

8. In the next dialog box, select the following options: 

• Authentication domain: DefaultAuth 

• Authentication type: User/Password 

• Application protocol: http 

• Host name: [enter in the name of the host where the DataFlux Data Management 
Server is residing] 

• Port Number: [This is the dmserver/soap/port from the dmserver.cfg file] 

• Proxy URL: Leave blank 
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9. Click Next to see the review dialog box. 

 

10. Verify the following: 

• The name is the same as the original one. 

• The host reflects the location of the DataFlux Data Management Server. 

• The port number matches what is in the dmserver.cfg file. 
 

11. Click Finish to complete the SAS Management Console changes. 
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SAS Data Quality Server 
In SAS 9.3, all functions and procedures that contain the DQSRV prefix are deprecated. SAS 
9.3 continues to support the DQSRV functions and procedures. However, when you use 
these language elements, you receive a warning message that these language elements are 
being deprecated. 

The DQSRV language elements are being replaced by the DMSRV language elements. Some 
functions and procedures are simply renamed. Other functions and procedures are being 
replaced by a new function or procedure. All of the changes are documented in the following 
tables. 

Note: The DQSVR functions were used with the DataFlux Integration Server. 
The DMSVR functions support the DataFlux Data Management Server. 

Description of Function Deprecated DQSRV 
Name 

New DMSRV 
Name 

Runs a file-type DataFlux dfProfile job on a 
server and returns a job identifier 

DQSRVPROFJOBFILE Not Applicable 

Runs a repository-type DataFlux dfProfile job 
on a server and returns a job identifier 

DQSRVPROFJOBREP Not Applicable 

Generates a profile Not Applicable DMSRVPROFILEJOB 
Runs a DataFlux dfPower Architect job on a 
server and returns a job identifier 

DQSRVARCHJOB DMSRVBATCHJOB 

Runs a process job Not Applicable DMSRVBATCHJOB 
Returns the status of a job that was 
submitted to the server 

DQSRVJOBSTATUS DMSRVJOBSTATUS 

Copies a job’s log file from a server DQSRVCOPYLOG DMSRVCOPYLOG 
Runs a data job Not Applicable DMSVRBATCHJOB 
Deletes a job’s log file from the server DQSRVDELETELOG DMSRVDELETELOG 
Terminates a job that is running on a server DQSRVKILLJOB DMSRVKILLJOB 
Authenticates a user on a server DQSRVUSER DMSRVUSER 
Returns the version of the server DQSRVVER DMSRVVERSION 

Replacing the DQSRV Functions with DMSRV Functions 

Deprecated Procedures 

Description of Procedure Deprecated 
Name New Name 

Runs a DataFlux dfPower Architect real-time service 
on a server 

PROC 
DQSRVSVC 

PROC 
DMSRVDATASVC 

Creates a data set that provides the name, type, 
and description of all DataFlux Architect and 
DataFlux dfPower Profile jobs that have been run on 
the server 

PROC 
DQSRVADM 

PROC DMSRVADM 

Runs a process service Not 
Applicable 

PROC 
DMSRVPROCESSSVC 

Deprecated Procedures 
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If the SAS Data Quality Server is being used via SAS code only (meaning used by calling the 
PROCS in SAS code and not with EDI), customers need to change the PROC names and 
update their SAS code to do the following: 

• Point to the new data or process jobs. 

Note: The architect jobs were upgraded. Even though the names are the same, the 
extensions change from Architect (.dmc) to Process (.djf) or Data (.ddf). 

• Point to the new profile jobs 

If the SAS Data Quality Server is a part of an Enterprise Data Integration deployment, the job 
updates are covered with the 9.2 to 9.3 migration 

Note that data quality functions might produce different results than DataFlux Data 
Management Studio or Server version 2.2 because the SAS Data Quality Server engine is 
based on version 2.1. For the correlating version of the Data Quality Server engine and the 
version of the DataFlux software it is based on, please see the following table:  

Version of the Data Quality 
Server Engine 

Version of the DataFlux 
software on which it is 

based 
9.3 2.1 

9.3M1 2.1 
9.3M2 2.3 

9.4 2.4 
9.4M1 2.5 
9.4M2 2.5 
9.4M3 2.7 

Please be aware of these versions and compare results if you are doing actions in Data 
Quality Server and DataFlux Data Management Studio or Server. 

If you are trying to call a single page dfPower real-time service as part of a DataFlux Data 
Management Studio or Server deployment, then add the following to the <DM Server install 
root>/etc/service.cfg file: 

DATASVC/IGNORE_DECLARED_VARS = yes 
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DataFlux Data Management Studio 2.1 to 
DataFlux Data Management Studio 2.2 or 
Later 
Each migration scenario requires specific actions. Refer to each of the following sections: 

• Configurations 

• Reference Sources 

• Data Connections 

• Repositories 

• Data and Process Jobs 

• Profile Jobs 

• Explorer Jobs 

• Accelerators 

• SAS Data Integration Studio 

• Other 

Configurations 
There are no changes in configuration settings between these two releases. All settings that 
were honored in 2.1 are honored in later releases. Some changes that need post-installation 
tasks include: 

• Backup app.cfg and dfwfproc.cfg in <DM Studio 2.2 install root>\etc 

• Copy app.cfg and dfwfproc.cfg from <DM Studio 2.1install root>\etc to <DM Studio 
2.2 install root>\etc 

• Open <DM Studio 2.2 install root>\etc\app.cfg and verify that the paths are correct 
for these items: 

 Licenses 

 QKB 

 USPS data 

 Canada data 

 World data 

Note: Do not migrate settings in any other files. 
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It is a good practice to ensure that the license is configured correctly. The best way to do 
this is with the License Manager, which is found in Windows Programs menu. 
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When you copy the user’s settings, it is copying CFG files from these locations: 

• %APPDATA%\DataFlux\DataManagement\2.1 to 
%APPDATA%\DataFlux\DataManagement\2.2 

• %APPDATA%\DataFlux\DataManagement\2.1\macros to 
%APPDATA%\DataFlux\DataManagement\2.2\macros 

 

 
 

• It does not copy anything from the "Logs" and "Repositories" directories. 
 

Note: Do not copy anything from Logs or Repositories. 

Once these post-installation tasks are complete, all configurations have been moved over. 

 

Reference Sources 
Once DataFlux Data Management Studio is installed, these need to be re-registered. Open 
DataFlux Data Management Studio 2.1 and navigate to Administration> Reference Sources. 
Open up DataFlux Data Management Studio 2.2 and navigate to the same location. 

 

DataFlux Data Management Studio 2.3 and later versions: 

For 2.3 and later versions, the following mapping exists: 

• %APPDATA%\DataFlux\DataManagement\2.1 to 
%APPDATA%\DataFlux\DMStudio\<instance>\ 

%APPDATA%\DataFlux\DataManagement\2.1\macros to 
%APPDATA%\DataFlux\ DMStudio\<instance>\macros 
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For each reference source that you want to copy, open up the properties in 2.1 and create a 
new Reference Source in 2.2. 

 

Copy the contents from 2.1 to 2.2. 
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The end result is that all desired resources are copied across. 

 

Data Connections 
Assuming that DataFlux Data Management Studio is being installed on the same box as the 
previous version of DataFlux Data Management Studio, no extra work is required to migrate 
any ODBC connections. If DataFlux Data Management Studio is being installed on a new 
box, then you need to manually migrate the ODBC connections that are defined in the ODBC 
Administrator. 

ODBC data connections defined on the box are automatically upgraded to the latest version 
of the DataFlux ODBC drivers. This means that both DataFlux dfPower and DataFlux Data 
Management Studio are using the same version of ODBC drivers. 

You need to move over any custom, DataFlux Federation Server, or localized Federation 
Server definitions that have been created as well. Use a utility of choice to copy definitions 
from <DM STUDIO 2.1 INSTALL ROOT>\etc\dftkdsn to <DM STUDIO 2.2 INSTALL 
ROOT>\etc\dftkdsn and credentials from %APPDATA%\DataFlux\dac\9.0 to 
%APPDATA%\DataFlux\dac\9.1. 

 

 

DataFlux Data Management Studio 2.3 and later versions: 

For Data Management Studio 2.3 and later versions, this copies content from  
<DM STUDIO 2.1/2.2 INSTALL ROOT>\etc\dftkdsn  
to  
<DM STUDIO 2.3/LATER INSTALL ROOT>\etc\dftkdsn  
 
and copies credentials from  
%APPDATA%\DataFlux\dac\9.0 or 9.1  
to  
%APPDATA%\DataFlux\dac\savedconn. 
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This is how the folders look prior to migration: 
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This is how the folders look after migration: 

 

 

Once this is done, 2.2 should have the same data connections as 2.1. This can be verified 
by comparing the 2.1 Data Connections riser against the 2.2 Data riser. 
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Repositories 
Depending on the type of repository, you might need to re-create the repository for File-
Based Data Storage, or you might need to create new repositories like for RDBMS-Based 
Data Storage. 

File-Based Data Storage 

Each repository that exists in 2.1, needs to be re-created in 2.2. It is highly recommended 
that you not upgrade the 2.1 repository because then 2.1 could not use the repository.  

Perform the following steps: 

1. Open 2.1 and go to the Administration > Repository Definitions. 

 

Except for the DataFlux Sample repository, each listed repository that needs to be 
available in 2.2 should be migrated. 

2. Open the repository definition. If the repository is connected, go ahead and 
disconnect. This enables you to copy and paste. 
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3. Open Windows Explorer and navigate to where you want to make the 2.2 repository 
folders. You need to create the physical locations on disk where the folders should 
reside before creating the new repository.  

Notice in the following example that a new folder is created and it is called DMP22. 

 

4. Open the new folder. Since the repository creation does not create folders, you need 
to create a couple more folders under DMP22 to create the new repository structure. 
The structure can be whatever is desired. In this example, we are going to create the 
same structure that exists for 2.1 but only under the DMP22 folder. 
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5. After creating the folders, and since this repository has a file-based data storage, 
you need to copy one file over to the new DataStorage location. Go back to the 2.1 
DataStorage location and copy the *.rps file to the 2.2 DataStorage location. In this 
example, we are copying C:\Repositories\test2\DataStorage\test2.rps to 
C:\Repositories\DMP22\test2\DataStorage\test2.rps. 

 

6. Now having created the folders and copied over the RPS file that we need, go back 
into DataFlux Data Management Studio and create the DMP 2.2 repository definition. 
In DataFlux Data Management Studio 2.2, navigate to Administration > Repository 
Definitions and create a new repository. If you feel confident, copy, paste, and edit 
from the 2.1 settings or use the Browse buttons to navigate to the specific folders. 

 

The highlighted differences between the 2.1 definition on the left and the 2.2 
definition on the right is that the two pieces of the repository live under the DMP22 
folder that was created. 

7. Cancel out of the 2.1 repository property window. Make sure that the settings for the 
2.2 repository are pointing to the new locations that were just created.  
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8. Select OK to save the changes. This results in the following dialog box 

 

9. Select OK. This shows the following in the 2.2 Repository Definitions screen: 

 

10. Right-click on the repository and select Upgrade. 

 

Or from the Tools menu, select the repository and choose Upgrade. 
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11. Once you select Upgrade, the following dialog box appears: 

 

12. Select Yes, as this repository is only for DMP 2.2. This starts the upgrade process. 
The end result should be a dialog box like the following 

 

13. Select Close. This takes you back to the Repository Definitions view. The new 
repository definition should look like the following: 

 

14. Select the new repository and select Connect either via right-click, toolbar, or Tools 
menu. 

 

The definition now looks like this: 
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RDBMS-Based Data Storage 

For RDBMS systems like Oracle, SQL Server, and so on, the process is a little different. It is 
not recommended to reuse the 2.1 repository, because the upgrade process means it can 
no longer be used with DataFlux Data Management Studio 2.1.  

To upgrade an RDBMS system, perform the following steps: 

1. Identify where the repository should be copied to. In this example, the copy is put 
into a new Oracle schema. 

In this example, we have a 2.1 repository that was created called 21 Repository. We 
are going to copy this repository. 
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2. In DataFlux Data Management Studio 2.1, open up the ODBC administrator and 
create a new connection. 
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3. After creating the new ODBC DSN, go back into DataFlux Data Management Studio 
and under the Data Connections riser, select Save User Credentials to save the 
connection credentials. 

 

The following display shows what an Oracle DSN provides: 

 

4. To copy the repository, contact your database administrator and ask them to create 
a copy of the current DataFlux repository. Once that is done, you need to configure 
the new Data Management version to work with this repository. Note that for the 
examples in this document, it assumes that the repository tables are prefixed with 
“cpy_”.  

5. Copy the 2.1 file storage location to be used with a 2.2 file storage configuration 

6. Copy over the saved credentials for the copy of the repository DSN 

7. Create a 2.2 repository using the file storage copy and the 2.1 repository copy 
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8. Copy everything that is in the file storage location from the original repository to the 
new one. 

 

9. Copy over any saved credential files that are stored. These can be found in 
%APPDATA%\DataFlux\dac\9.1 and should be copied to 
%APPDATA%\DataFlux\dac\9.1. 

 

10. Open DataFlux Data Management Studio 2.2 and go to Administration > Repository 
Definitions and create a new repository 

11. Create the new repository configuration in 2.2 via the Administration > Repository 
Definition screen. Below, see the 2.1 configuration on the left and the 2.2 version on 
the right. Notice that except for the name, the rest of the configuration is the same. 

 

DataFlux Data Management Studio 2.3 and later: 

• Saved credentials are stored in %APPDATA%\DataFlux\dac\savedconn. Data 
Management Studio still reads saved configurations from 
%APPDATA%\DataFlux\dac\9.1. 
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12. Cancel out of the 2.1 repository definition. Save the 2.2 repository definition. An 
error notification about needing to upgrade is displayed. 

 

13. Click OK and then select the repository definition that was just created, right-click, 
and from the resulting menu select Upgrade. 

 

 

14. Select Yes to start the upgrade process.  
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When it is complete, you should see something like the following: 

 

15. Select Close. Select the definition again and choose Connect. 

 

The repository is now connected. 
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16. Verify the contents. If you go look at the Folders riser for both DataFlux Data 
Management Studio 2.1 and 2.2, the original repository and the 2.2 upgraded 
repository should be relatively the same with 2.2 containing more items. 

 

The extra 2.2 folders are foundations and potentially Shared Data. 

Repeat this section for every 2.1 repository that you want to migrate. It is recommended 
that you run 2.1 and 2.2 side by side for a period of time to make sure that you are getting 
the same results. Once you determine that the cutover to 2.2 can be made, it is 
recommended to remove the 2.2 repositories and repeat the steps one more time to ensure 
that everything that was at 2.1 makes it to 2.2. 

Data and Process Jobs 
When the file storage location of an existing repository is copied to a new location, this 
covers the migration of the process and data jobs. No further work is needed. 

Profile Jobs 
When the data storage location of an existing repository is copied over, this covers the 
migration of the profile jobs and reports. No further work is needed. 

Explorer Jobs 
When the data storage location of an existing repository is copied over, this covers the 
migration of the explorer jobs. No further work is needed. 

Accelerators 
This was handled when the file storage part of the repository was copied over. It is not 
recommended that you use any copied Accelerators. Contact your sales rep to make sure 
that you have the correct supported version. 
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SAS Data Integration Studio 
Note: This section assumes that a user has already migrated from dfPower 8.* to DataFlux 
Data Management Studio 2.1. 

We also need Open SAS Data Integration Studio and go to Tools > Options > Data 
Quality to register the path where DataFlux Data Management Studio 2.2 lives. 

 

For the "DataFlux Installation Folder:" value, navigate to the 2.2 installation root (for 
example, "C:\Program Files\DataFlux\DMStudio\2.2"), and save the location. 

 

Click OK and then re-start SAS Data Integration Studio. 

Other 
Items that are found in the Business Rule Manager interface come over when the repository 
is migrated. By default, all migrated Rules and Tasks show up Data Management Studio in 
the Folders riser under the Shared Data folder. 
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DataFlux Data Management Server 2.1 to 
DataFlux Data Management Server 2.2 or 
Later 
Each migration scenario requires specific actions. Refer to each of the following sections: 

• Configurations 

• Reference Sources 

• Data Connections - Windows 

• Data Connections - UNIX 

• Repositories 

• Data and Process Jobs 

• Profile Jobs 

• Accelerators 

• Security 

• Command Line Execution 

• SAS Management Console 

• SAS Data Quality Server 

Configurations 
Configuration settings need to be copied from the following places: 

• <DM_SERVER_2.1_INSTALL_ROOT> 

 etc/dftkdsn to <DM_SERVER_2.2_INSTALL_ROOT>/etc/dftkdsn > copy all 
*.dftk files  

 etc/dsn to <DM_SERVER_2.2_INSTALL_ROOT>/etc/dsn > copy all *.cfg files  

 etc/macros to <DM_SERVER_2.2_INSTALL_ROOT>/etc/macros > copy all *.cfg 
files  

 etc/security to <DM_SERVER_2.2_INSTALL_ROOT>/etc/security > copy *  

 etc/ 

o dfwfproc.cfg 

o dfwsvc.cfg 

o dmserver.cfg 
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o macros.cfg  

o Specific app.cfg settings as needed. These could be any user-modified 
settings that do not include a path or system command. 

 

This table displays the DataFlux Data Management Server settings for v. 2.2 and later and 
their v. 2.1 equivalents: 

2.2 and Later Setting 2.2 File 
2.1 Setting 

(equivalent unless  
otherwise noted) 

2.1 File 

DATASVC/IGNORE_DECLARED_VARS service.cfg -- -- 
DATASVC/THREAD_STACK_SIZE service.cfg Same dfwsvc.cfg 
DMSERVER/CHILD/LISTEN_HOST dmserver.cfg DMSERVER/WLP/CHILD/LISTE

N (one part of this multi-part 
setting string) 

-- 

DMSERVER/CHILD/LISTEN_PORT dmserver.cfg DMSERVER/WLP/CHILD/LISTE
N (another part of this multi-
part setting string) 
DMSERVER/WLP/CHILD/TCP_P
ORT  

-- 

-- -- DMSERVER/DATA_SVC/DEBUG dmserver.cfg 
-- -- DMSERVER/DATA_SVC/LOG dmserver.cfg 
DMSERVER/IPACC/ALL_REQUESTS dmserver.cfg Same -- 
DMSERVER/IPACC/POST_DELETE dmserver.cfg Same -- 
DMSERVER/JOBS_MAX_NUM dmserver.cfg DMSERVER/PROC_JOB/MAX_N

UM 
dmserver.cfg 

DMSERVER/JOBS_NO_STATE dmserver.cfg -- -- 
DMSERVER/JOBS_ROOT_PATH dmserver.cfg Same -- 
DMSERVER/LOG_CHUNK_SIZE dmserver.cfg Same -- 
DMSERVER/NO_WORK_SUBDIRS dmserver.cfg -- -- 
DMSERVER/SECURE dmserver.cfg Same -- 
DMSERVER/SECURE/DEFAULT_ACE_P
UBLIC 

dmserver.cfg -- -- 

DMSERVER/SECURE/DEFAULT_ACE_
USERS 

dmserver.cfg -- -- 

DMSERVER/SECURE/GRP_ADMIN dmserver.cfg Same -- 
DMSERVER/SECURE/GRP_ALLOW 
 

dmserver.cfg Same -- 

DMSERVER/SECURE/GRP_DENY dmserver.cfg Same -- 
DMSERVER/SOAP/CONNS_BACKLOG dmserver.cfg Same -- 
DMSERVER/SOAP/DATA_SVC/JOB_C
OUNT_MAX 

dmserver.cfg Same -- 

DMSERVER/SOAP/DATA_SVC/JOB_C
OUNT_MIN 

dmserver.cfg Same -- 

DMSERVER/SOAP/DATA_SVC/MAX_E dmserver.cfg Same -- 
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2.2 and Later Setting 2.2 File 
2.1 Setting 

(equivalent unless  
otherwise noted) 

2.1 File 

RRS 
DMSERVER/SOAP/DATA_SVC/MAX_N
UM 

dmserver.cfg Same -- 

DMSERVER/SOAP/DATA_SVC/MAX_R
EQUESTS 

dmserver.cfg Same -- 

DMSERVER/SOAP/DATA_SVC/MAX_R
UNTIME 

dmserver.cfg -- -- 

DMSERVER/SOAP/DATA_SVC/PRELOA
D 

dmserver.cfg Same -- 

DMSERVER/SOAP/DATA_SVC/PRELOA
D_ALL 

dmserver.cfg Same -- 

DMSERVER/SOAP/DATA_SVC/QUEUE dmserver.cfg Same -- 
DMSERVER/SOAP/IGNORE_NS dmserver.cfg Same -- 
DMSERVER/SOAP/LOG_PACKETS dmserver.cfg Same -- 
DMSERVER/SOAP/LISTEN_HOST dmserver.cfg -- -- 
DMSERVER/SOAP/LISTEN_PORT dmserver.cfg Same -- 
DMSERVER/SOAP/PROC_SVC/MAX_N
UM 

dmserver.cfg Same -- 

DMSERVER/SOAP/RDWR_TIMEOUT dmserver.cfg Same -- 
DMSERVER/SOAP/RETURN_NULLS dmserver.cfg Same -- 
DMSERVER/SOAP/SSL dmserver.cfg Same -- 
DMSERVER/SOAP/SSL/CA_CERT_FILE dmserver.cfg Same -- 
DMSERVER/SOAP/SSL/CA_CERT_PAT
H 

dmserver.cfg Same -- 

DMSERVER/SOAP/SSL/KEY_FILE dmserver.cfg Same -- 
DMSERVER/SOAP/SSL/KEY_PASSWD dmserver.cfg Same -- 
DMSERVER/THREADS/COUNT_MAX dmserver.cfg Same -- 
DMSERVER/THREADS/IDLE_MAX dmserver.cfg Same -- 
DMSERVER/THREADS/IDLE_TIMEOUT dmserver.cfg Same -- 
-- -- DMSERVER/WLP/CHILD/SHM_

DIR 
dmserver.cfg 

DMSERVER/WLP/DATA_SVC/MAX_NU
M 

dmserver.cfg Same -- 

DMSERVER/WLP/LISTEN_HOST dmserver.cfg DMSERVER/WLP/SVR/LISTEN 
(one part of this multi-part 
setting string) 

-- 

DMSERVER/WLP/LISTEN_PORT dmserver.cfg DMSERVER/WLP/SVR/LISTEN 
(another part of this multi-
part setting string) 

dmserver.cfg 

-- -- DMSERVER/WLP/SVR/LISTEN_
PORT 

-- 

DMSERVER/WORK_ROOT_PATH dmserver.cfg Same -- 
DataFlux Data Management Server v. 2.2 Settings and the v. 2.1 Equivalents 
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It is a best practice to ensure that these configurations in dmserver.cfg have valid ports: 

• DMSERVER/SOAP/LISTEN_PORT 

• DMSERVER/WLP/LISTEN_PORT 

Note: If these are not set, it could lead to issues if there is an Integration 
Server or multiple data management servers installed on the same host. 

 

If dfPower real-time services are still being used in a DataFlux software deployment, then 
add the following to the <DM Server install root>/etc/service.cfg file. 

DATASVC/IGNORE_DECLARED_VARS = yes 

Reference Sources 
If the configurations for DataFlux Data Management Server 2.1 are brought over, then this 
should take care of the registration of the data packs for US address data, Canadian address 
data, US geocode and phone data as well as the world data. No extra steps should be 
needed other than to verify that the locations have been configured correctly. 

Data Connections - Windows 
If the DataFlux Data Management Server is being installed on the same box as the previous 
version of the DataFlux Data Management Server, then no extra work is required to migrate 
any ODBC connections. If the DataFlux Data Management Server is being installed on a new 
box, then manually migrate the ODBC connections are defined in the ODBC Administrator. 

ODBC data connections defined on the box are automatically upgraded to the latest version 
of the DataFlux ODBC drivers. This means that both DataFlux dfPower and DataFlux Data 
Management Studio use the same version of ODBC drivers. 

If a 32-bit version of the 2.1 DataFlux Data Management Server was installed on a 64-bit 
box, and if the 64-bit version of 2.2 DataFlux Data Management Server is installed on the 
same box, then the ODBC DSNs must be re-created through the 64-bit version of the ODBC 
Data Source.  

DataFlux Data Management Studio 2.3 and later versions: 

• DMSERVER/WLP/LISTEN_PORT no longer needs to be set by default. 
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Perform the following steps: 

1. Open the 32-bit ODBC Administrator via DataFlux Data Management Studio 2.2 Data 
Connections Riser. 

 

2. Open the 64-bit ODBC Administrator via the Control Panel. 

 

 

There is no way to distinguish which version is 32-bit or 64-bit. In the above picture, 
the 32-bit is on the left and the 64-bit is on the right. 
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3. Move any custom, DataFlux Federation Server, or localized Federation Server 
definitions that have been created as well. Use a utility of choice to copy definitions 
from <DM Server 2.1 install root>\etc\dftkdsn to <DM Server 2.2 install 
root>\etc\dftkdsn and credentials from <DM Server 2.1 install root>\etc\dsn to <DM 
Server 2.2 install root>\etc\dsn. 

The 2.1 definitions should look like the following: 
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After copying the files, the 2.2 definitions should look like the following: 

 

 

4. Verify that 2.2 has the same data connections as 2.1 by comparing the 2.1 Data 
Connections riser against the 2.2 Data riser. 
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Data Connections - UNIX 
If DataFlux Data Management Server 2.2 is being installed on the same box as DataFlux 
Data Management Server 2.1, then it is recommended that the ODBC connections already 
defined in the ODBC.ini file for DataFlux Data Management Server 2.1 be re-created in the 
2.2 ODBC.ini file. This ensures that the supported ODBC drivers are used. ODBC settings 
are per application and are not set system-wide. The dfdbconf utility located in <DM Server 
install root>/bin should be used to re-create the DSNs. 

Once the connections are re-created, the next step is to bring over any saved credentials. 
On UNIX servers, if dfdbview was used to save the credentials, these can be found in the 
user’s home directory under the .dfpower directory. If DataFlux Data Management Server 
2.2 is being installed under the same user ID as the 2.1 version, then the 2.2 version uses 
those credentials in the .dfpower directory. If a different user is doing the installation or if 
the server is being installed on a different box, then these settings should be copied over. 

One other location to look for saved credentials is in <DM Server 21 root>/etc/dsn. 
Anything in this directory should be copied over to <DM Server 22 root>/etc/dsn. 

Last but not least, any SAS, DataFlux Federation Server, or custom connections in <DM 
Server 21 root>/etc/dftkdsn need to be copied to <DM Server 22 root>/etc/dftkdsn. 

Repositories 
This topic tells you how to upgrade the data storage portion of a DataFlux Data 
Management Server repository. Existing repositories are displayed in the Data Connections 
folder. If no repositories exist, then only the default DataFlux Sample is visible. 

If DataFlux Data Management Server 2.1 is using a database for its data storage, the DSN 
must be configured, and you need to know whether any prefix is used. If the DSN and or 
prefix are not known, look in the *.rcf file that is located in the <DM Server 22 
root>/etc/repositories directory. Perform the following steps: 

1. Confirm that you have two connections in DataFlux Data Management Studio 2.1. The 
first connection is the current DataFlux Data Management Server 2.1 repository. The 
second hosts the copy of the repository to be upgraded. 
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2. In DataFlux Data Management Studio 2.1, save the credentials for both. 

3. To copy the repository, contact your database administrator and ask them to create a 
copy of the current DataFlux repository.  

4. Once that is done, configure the new Data Management version to work with this 
repository. Note that for the examples in this document, it assumes that the 
repository tables are prefixed with “cpy_”.  

Note: It is highly recommended that the "Table prefix" option be used to identify that 
this is a copy. Even if the recommendation of putting the copy in a different schema 
were used, this would be another way to identify that this is not an original repository. 

5. Upgrade the copy so that DataFlux Data Management Server 2.2 can use it. If the 
DSN does not exist on the machine that has latest version of DataFlux Data 
Management Studio, go ahead and create it. Once the DSN is created, be sure to save 
the user credentials.  

6. Create the new repository configuration in 2.2 via the Administration > Repository 
Definition screen. Notice that the "Folder" configuration is left blank in the DataFlux 
Data Management Studio configuration. This is done on purpose.  
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7. Save the 2.2 repository definition. An error notification about needing to upgrade is 
displayed. 

 

8. Click OK and then select the repository definition that was just created, right-click, 
and from the resulting menu select Upgrade. 

 

 

9. Select Yes to start the upgrade process.  
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At the end, you should see something like the following: 

 

10. Select Close. Select the definition again and choose Connect. 

 

This connects the repository. 
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Now that we have created the repository, do these two things: 

• Copy the repository configuration file to the server 

• Copy or save credential files to the server. 

Regardless whether the server is UNIX or Windows based, the repository configuration file 
(.rcf) is saved in the <DM Server root>/etc/repositories directory. The Studio RCF file needs 
to be copied to this location.  

Perform the following steps: 

1. Rename the default RCF file that came with DataFlux Data Management Server. 

 

2. Locate the Studio RCF file and copy it to the Server. If you followed the screenshots, 
the repository was configured as being private. This means that the RCF file can be 
found by going to %APPDATA%\DataFlux\DataManagement\2.2\repositories or 
%APPDATA%\DataFlux\DMStudio\<instance>\etc\repositories. 
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If it is not in this location, then look in <DM Studio root>\etc\repositories. 

3. Copy the "21 Server Repository Copy.rcf" file to the server. In the following display, 
FileZilla is used to SFTP the file to the server. 

 

4. Copy the saved credentials on your DataFlux Data Management Studio box to the 
DataFlux Data Management Server machine. The saved credentials are in the 
%APPDATA%\DataFlux\dac\9.1 or in %APPDATA%\DataFlux\dac\savedconn 
directory; copy them to the <DM Server root>/etc/dsn directory. 
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5. Create the DSN on the server. The DSN name that you need to create is defined in 
the RCF file. From the Server host, you can view the file to ensure that you create the 
correct DSN name. 

 

6. Create the DSN (assuming that you know what data source this should be connecting 
to). 
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7. View the contents of the 2.1 Server. The file storage location of the DataFlux Data 
Management Server is always <DM Server 22 install root>/var.  

8. Copy the contents of the following folders from 2.1 to 2.2: 

• batch_jobs 

• data_services 

• process_services 

9. If you want the ability to declare inputs and outputs on data services as introduced in 
DataFlux Data Management Server 2.2, then set the following in the service.cfg file 
found in <DM Server install root>/etc/: 

DATASVC/IGNORE_DECLARED_VARS = YES 

Setting this value enables data services to run as they did in DataFlux Data 
Management Server 2.1. Note that this was not needed with the Integration Server. 

Data and Process Jobs 
This is handled with the copying of jobs from the 2.1 var directory to the 2.2 var directory. 

Profile Jobs 
Handled with the copying and upgrading of the data storage portion of the repository. 

Accelerators 
If any Accelerators have been installed with DataFlux Data Management Server 2.1, contact 
your account representative to obtain the correct accelerator that is compatible with version 
2.2. 
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Security 
This is handled with the copying of jobs from the 2.1 var directory to the 2.2 var directory. 

 
 

Command Line Execution 
The batch jobs execution utility used in the 2.1 release has the following command line 
arguments: 

usage: dmpexec [options] 
options: 
     -c <file>            read configuration from <file> 
     -j <file>            execute job in <file> 
     -l <file>            write log to <file> 
     -i <key>=<value>     set input <key> to <value> 
     -o <key>=<value>     set option <key> to <value> 
     -b <key>=<value>     set job option <key> to <value> 

The batch jobs execution utility used in release 2.2 and beyond has the following command 
line arguments: 

usage: dmpexec [options] 
options: 
     -c <file>            read configuration from <file> 
     -j <file>            execute job in <file> 
     -l <file>            write log to <file> 
     -i <key>=<value>     set input <key> to <value> 
     -o <key>=<value>     set option <key> to <value> 
     -b <key>=<value>     set job option <key> to <value> 
     -a                   authenticate using Authentication Server 

The only added option in 2.2 is the ability to run a script that enables you to Authenticate. If 
the job needs to run with a user’s credentials, the credentials would be stored in a 
configuration file that would contain something like the following: 

base/auth_server_loc 
=iom://servername.domain.com:21030;protocol=bridge;user=userid,pass=password 

Then it is passed in on the command line with the following options: 

> bin/dmpexec -a -c "dmpexec_auth.cfg" -l "dmpJob.log" –j 
"path/to/architect.ddf" 

DataFlux Data Management 2.7 and later versions: 

In the DataFlux Data Management 2.7 release, Data Management Studio, Data Management 
Server, and SAS Federation Server now use the SAS Metadata Repository for user authentication. 
This means that DataFlux Authentication users need to be ported to SAS Metadata Repository and 
user information in the Data Management Server and SAS Federation Server needs to be updated 
to use the new SAS Metadata Repository user IDs. This is all covered in the Update Security Files 
after Exporting Users and Groups section. 
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SAS Management Console 
When moving from SAS 9.2 to SAS 9.3, a DataFlux Data Management Server entry is 
created in metadata. This entry might need to be renamed and a new DataFlux Data 
Management Server entry created with the same name. This allow Data Integration Studio 
jobs to continue to run without having to be updated to handle the change in servers.  

Before following the next set of steps, look at the properties of the defined DataFlux Data 
Management Server and validate that the TCP/IP connection is pointing to the correct host 
and port. If so, no changes are needed. If they are not, please follow the next set of steps 
to define a DataFlux Data Management Server that points to the correct host and port. 

1. Open SAS Management Console and rename the existing DataFlux Data Management 
Server entry. 

 

For the example, append " – original" to the end of the name. 
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2. Create a new server entry using the same name as the original Server entry. 

 

3. In the New Server Wizard dialog box, select Http Server and then select Next. 

 

4. Rename the Http Server to the original entry name. In this example, name = 
"DataFlux Data Management Server - rdcesx09020". 
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5. In the next dialog box, make sure the following information is entered: 

• For DataFlux Data Management Server 2.2: Software Version = 2.2 

 For DataFlux Data Management Server 2.3: Software Version = 2.3 

 For DataFlux Data Management Server 2.4: Software Version = 2.4 

 For DataFlux Data Management Server 2.5: Software Version = 2.5 

 For DataFlux Data Management Server 2.6: Software Version = 2.6 

 For DataFlux Data Management Server 2.7: Software Version = 2.7 

• Vendor = DataFlux Corporation 

• Base Path(s) = / 

• Application Server Type = DataFlux Data Management Server 

 

6. Select the New button. In the resulting dialog box, select OK. 

7. Select Next. 
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8. In the next dialog box, select the following options: 

• Authentication domain: DefaultAuth 

• Authentication type: User/Password 

• Application protocol: http 

• Host name: [enter in the name of the host where the DataFlux Data Management 
Server is residing] 

• Port Number: [This is the dmserver/soap/port from the dmserver.cfg file] 

• Proxy URL: Leave blank 
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9. Click Next to see the review dialog box. 

 

10. Before selecting Finish, verify the following: 

• The name is the same as the original one. 

• The host reflects the location of the DataFlux Data Management Server. 

• The port number matches what is in the dmserver.cfg file. 
 

11. Click Finish to complete the SAS Management Console changes. 

SAS Data Quality Server 
This section assumes that a user has already migrated jobs and content from DataFlux 
dfPower Studio to DataFlux Data Management Studio 2.1. There are no changes needed in 
going from version 2.1 to 2.2. 
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Chapter 5: Update Security Files 
After Exporting Users and Groups  
Introduction 
Use the dftool utility to update local security files after you export users and groups from a 
DataFlux Authentication Server to a SAS Metadata Server. In the security files, the dftool 
utility replaces DataFlux Authentication Server IDs with SAS Metadata Server IDs. The 
update process ensures that the security files are synchronized with the SAS Metadata 
Server. 

The dftool utility shows and logs all IDs that were replaced, and also displays and logs any 
DataFlux Authentication Server IDs that remain. IDs are replaced only if matching users or 
groups are found on the SAS Metadata Server. 

Replacing or removing all DataFlux Authentication Server IDs ensures appropriate access to 
server resources. After running dftool, restart the DataFlux Data Management Server. 

Prerequisites 
The prerequisites for running the dftool utility are as follows: 

• As needed, install, update, configure, and start your SAS Metadata Server. 

• On the DataFlux Authentication Server, make sure that all users and groups were 
successfully exported to the SAS Metadata Server, as described in the DataFlux 
Authentication Server: Administrator’s Guide, at 
http://support.sas.com/documentation/onlinedoc/dfauthserver/index.html. 

• Obtain login credentials that are recognized by the SAS Metadata Server. The 
credentials must meet the following requirements: 

o On the SAS Metadata Server, the credentials must be granted the Read Metadata 
permission. 

o On the DataFlux Data Management Server, the credentials must have Read, Write, 
and Delete permissions for the following directories: 

dmserver-install-path\etc\security 
dmserver-install-path\var 

o You can enter credentials on the command line when you run dftool, or you can 
enter default credentials into a configuration file, as described in Specify Default 
Credentials for dftool. 

http://support.sas.com/documentation/onlinedoc/dfauthserver/index.html
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• If the DataFlux Data Management Server runs in the UNIX operating environment, 
then set the environment variable TKERSA2_LIB_PATH as follows: 

TKERSA2_LIB_PATH=/dmserver-install-
path/SASHome/DataManagementServer/2.7/dmserver/lib/tkts 
export TKERSA2_LIB_PATH 

• Configure the DataFlux Data Management Server to authenticate using the SAS 
Metadata Server. Specifically, in the file dmserver-install-path\etc\app.cfg, the value 
of configuration option BASE/AUTH_SERVER_LOC needs to be the fully qualified 
network name of the SAS Metadata Server. If you have a clustered SAS Metadata 
Server, then the network name needs to identify the cluster configuration file. 

• To generate a log file for dftool, the following configuration file must be present on the 
server host: dmserver-install-path\etc\dftool.log.xml. If the DataFlux Data 
Management Server was recently upgraded, then the configuration file is installed 
with the name dftool.log.xml.new. This filename has to be changed before a log file 
can be generated by the dftool utility. The .new extension must be removed from the 
filename. 

Run the dftool Utility 
Follow these steps to run the dftool utility: 

1. Meet the prerequisites in the preceding topic. 

2. Open a shell window on the host of the DataFlux Data Management Server. Change to 
the following directory and enter the following command: 

dmserver-install-path\bin> dftool dismigrtsec 

Note: In certain Windows operating environments, you are required to open an 
Administrator: Command Prompt window. One way to open this window is to enter 
the following text in Search programs and files: 

command prompt - Administrator 

3. The dftool utility displays a prompt to enter alternate credentials for connecting to the 
SAS Metadata Server. Select Enter to bypass the entry of alternative credentials. 

4. The dftool utility displays its activities and exits. For further information about dftool 
processing, including the copying and renaming of security files, see the next topic, 
Summary of Execution. 

5. Examine the shell text or the log files to ensure that all IDs from the DataFlux 
Authentication Server were replaced. Two log files are generated each time you run 
dftool: dftool.log and dftool_security.log. The log files are located in the directory 
<dmserver-install-path>\var. Dftool.log is the platform debug log file. 
Dftool_security.log is a summary log file that lists only the DataFlux Authentication 
Server IDs that were not matched and replaced by SAS Metadata Server IDs. 
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If no unmatched IDs from the DataFlux Authentication Server remain, then the 
summary log file is empty. If unmatched IDs are found, then the summary log file 
contains an entry in the following format for each affected security file: 

unknown old ID:  'FF4ADD49C7599BA479FB9C13C742E8C0' 
unknown old ID:  'FF4ADD49C7599BA479FB9C13C742E8C1' 
Processed file:  'C:\Program Files\DataFlux\DMServer\2.7 
\bin\..\etc\security\users' 

If the log files indicate that unmatched IDs remain, then consider running PROC 
ASExport again on your DataFlux Authentication Server(s) as described in the 
DataFlux Authentication Server: Administrator’s Guide. After the export, run dftool 
again on the DataFlux Data Management Server. 

If no DataFlux Authentication Server IDs are found (summary log file empty), then 
the cause might be one or more following: 

o All IDs were previously replaced. 
o Your credentials for running dftool do not have appropriate permission to 

read or display users and groups from the SAS Metadata Server. 
o PROC ASExport did not run or did not run correctly. Examine the log file to 

see the users and groups that were exported to the SAS Metadata Server. 

If PROC ASExport indicates that all users and groups have been exported, unmatched 
IDs can still exist on the DataFlux Data Management Server. To resolve this condition, 
verify that the unmatched users and groups are not present on your SAS Metadata 
Server or DataFlux Authentication Server(s). Next, delete those users or groups from 
the security settings on your DataFlux Data Management Server, using the 
administrative interface in DataFlux Data Management Studio. 

6. Restart the DataFlux Data Management Server so that the server can read the new 
security files into memory. 

Summary of Execution 
The dftool utility runs as follows: 

1. Open app.cfg to determine the network name of the SAS Metadata Server, as 
specified by the option BASE/AUTH_SERVER_LOC. Also look for alternative credentials 
in the options BASE/AUTH_SERVER_USER and BASE/AUTH_SERVER_PASS. 

2. Request from the SAS Metadata Server the users and groups that were migrated from 
the DataFlux Authentication Server. If no users or groups are returned, dftool exits. 

3. Search the DataFlux Data Management Server security files for user and group IDs 
that were generated by the DataFlux Authentication Server. If one is found, and if the 
associated user or group has a match on the SAS Metadata Server, then copy and 
rename the security file. In the original security file, replace the old ID with the ID 
from the SAS Metadata Server. Rename the file with a numeric suffix such as .001 or 
.012. The suffix indicates the number of times that the original security file has been 
replaced by previous runs of the dftool utility. 

4. If an ID from the DataFlux Authentication Server is found, and if a matching user and 
group is not found, then log the unmatched ID for that security file. 
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Specify Default Credentials for dftool 
Follow these steps to define default credentials that are used by the dftool utility to connect 
to the SAS Metadata Server. Default credentials are helpful if you are not running dftool 
with credentials that provide read metadata access on the SAS Metadata Server. 

1. Edit the file dmserver_install_path\etc\app.cfg. 
2. Add or update the following configuration options: 

BASE/AUTH_SERVER_USER=UserName 
BASE/AUTH_SERVER_PASS=SASencodedPassword 

Note: To encrypt the password, use PROC PWENCODE, as described in the Base SAS 
Procedures Guide. 

3. Save and close the configuration file. 

4. Run dftool again to pick up the changes in the configuration file. 
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Chapter 6: Updating Servers 
during Migration 
If you are upgrading from a release prior to 15w12 (March 2015), you might need to take 
additional manual steps to update your servers.  
 

Note: To determine your product’s release, refer to the SAS 9.4 Revision Numbers 
and Associated Documentation page on the SAS Support site. 

DataFlux Web Studio Server 
If you have DataFlux Web Studio Server during migration, you should update the repository 
associated with DataFlux Web Studio Server and re-create the lineage content. 
 
Upgrading the DataFlux Web Studio Server repository follows the same steps as updating 
the DataFlux Data Management Server’s repository. 

Perform the following steps to move from DataFlux Web Studio 2.3 to 2.4: 

1. Confirm that you have connections in DataFlux Data Management Studio 2.3 to the 
current repository and to the copy of the repository to be upgraded. 

DataFlux Web Studio Server is using a database for its data storage, so the DSN 
needs to be configured. If the DSN and or prefix are not known, look in the *.rcf file 
that is located in the <Web Studio Server root>/etc/repositories directory.  

2. In DataFlux Data Management Studio 2.3, save the credentials for both. 

3. To copy the repository, contact your database administrator and ask them to create a 
copy of the current Web Studio Server repository. It is highly recommended that the 
"Table prefix" option be used to identify that this is a copy. Even if the 
recommendation of putting the copy in a different schema were used, this would be 
another way to identify that this is not an original repository. 

4. Upgrade the copy so that DataFlux Web Studio 2.4 Server can use it. If the DSN does 
not exist on the machine that has DataFlux Data Management Studio, go ahead and 
create it. Once it is created, be sure to save the user credentials. 

5. Run DataFlux Data Management Studio. 

6. From the Administration riser, register the repository in DataFlux Data Management 
Studio.  

7. Name the repository “Web Studio Server 24 Repository”. The "Folder" configuration is 
left blank. This is done on purpose. When we save the configuration, the DataFlux 
Data Management Studio should register the repository with no further prompts or it 
might ask whether you would like to upgrade the repository. If prompted for this 
upgrade, accept it.  

8. Once the upgrade is complete, connect to the repository. A green circle in the 
repository screen confirms it is connected. 

http://support.sas.com/kb/50/493.html
http://support.sas.com/kb/50/493.html
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Now that we have created the repository, do these two things: 

• Copy the repository configuration file to the server 

• Copy or save credential files to the server. 

Regardless whether the server is UNIX or Windows based, the repository configuration file 
(.rcf) is saved in the <Web Studio Server root>/etc/repositories directory. The Studio RCF 
file needs to be copied to this location.  

Perform the following steps: 

1. Rename the default RCF file that came with Web Studio Server. 

2. Locate the Studio RCF file and copy it to the Server.  

If you followed the steps so far, the repository was configured as being private. This 
means that the RCF file can be found by going to 
%APPDATA%\DataFlux\DMStudio\<instance>\etc\repositories. If it is not in this 
location, then look in <DM Studio root>\etc\repositories.  

3. Copy the "Web Studio Server 24 Repository.rcf" file to the server. 

4. Copy the saved credentials on our DataFlux Data Management Studio box to the 
Server. The saved credentials are in %APPDATA%\DataFlux\dac\savedconn directory 
and should be copied to the <Web Studio Server root>/etc/dsn directory. 

5. Create the DSN on the server. The DSN name is defined in the RCF file. From the 
server host, you can view the file to make sure we create the correct DSN name 
(assuming that you know what data source this should be connecting to) 

6. Once the DSN is created, start the DataFlux Web Studio Server. 

7. Update Lineage Metadata in repository by remotely submitting the jobs on the 
DataFlux Web Studio Server.  

a. DataFlux Data Management Studio  Data Management Servers riser bar  
Select your DataFlux Web Studio Server and login. 

b. Run job: WSServer\Batch Jobs\Lineage\L_ClearAllLineageData 
c. Run job: WSServer\Batch Jobs\Business Data\BDG_UpdateAllLineage 

 
Note: If you do not complete the second run, you could get errors in the 
Relationship diagram in DataFlux Web Studio, like “The Relationship service 
was unable to load the subject item identified by the attributes below…” 

 
Your DataFlux Web Studio Server is now migrated. 
 
For customers upgrading to 2.4 there is an issue in that several columns in existing 
repository tables are not automatically updated. Customers need to contact customer 
support to obtain the Hotfix to resolve this. Here is the link to the SAS note: 
http://support.sas.com/kb/50/160.html. 
 

http://support.sas.com/kb/50/160.html
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Related Servers 
If your configuration includes the following servers, see the migration instructions in their 
respective administration guides:  
 
DataFlux Authentication Server. See the migration instructions in the DataFlux 
Authentication Server: Administrator’s Guide, which is available from this URL: 
http://support.sas.com/documentation/onlinedoc/dfauthserver/  
 
SAS Federation Server 3.2 and later. See the migration instructions in the SAS Federation 
Server: Administrator's Guide, which is available from this URL: 
http://support.sas.com/documentation/onlinedoc/fedserver 
 
DataFlux Federation Server 3.1 and earlier. See the migration instructions in the DataFlux 
Federation Server: Administrator's Guide, which is available from this URL: 
http://support.sas.com/documentation/onlinedoc/dffedserver/ 
 

DataFlux Data Management Studio or Server 2.7 and later versions: 

DataFlux Data Management Studio 2.7 is integrated only with SAS Metadata Server and pulls its 
list of available servers from those defined in SAS Management Console. Register the Web Studio 
Server in SAS Management Console. For more information, see the Defining a New Server topic 
in the Server Manager section in the product Help for SAS Management Console.  

 
You need to define a new HTTP content server with a base path of '/' and an application server 
Type of DataFlux Data Management Server. This step must be performed for both new 
installations and for existing installations. Once the Web Studio Server has been registered in SAS 
Management Console, it can be displayed in the Data Management Servers riser in DataFlux Data 
Management Studio. 

http://support.sas.com/documentation/onlinedoc/dfauthserver/
http://support.sas.com/documentation/onlinedoc/fedserver
http://support.sas.com/documentation/onlinedoc/dffedserver/
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Visual Process Orchestration Server 
 
Saving Directory Content Prior to Migration: 

1. Start the SAS Management Console (sasadm) 

2. Locate your Process Orchestration jobs in the SAS Folders tree in the SAS 
Management Console. 

3. Follow the steps in the SAS 9.4 Intelligence Platform: System Administration Guide to 
export ALL to a SAS package file (SPK). 
 
Note: Be sure to check the check box to include dependent objects. 

4. Proceed with the migration steps below. 

 
Removing the Product from SAS Metadata Server: 

1. Start the SAS Management Console (sasadm) 

2. Connect to the system that you want to recover. 

3. Select the Search tab.  

4. In the search field type: Process Orchestration 

5. In the result pane, select all items.  

6. Now delete these items. Click the Yes to all button to continue. The remaining items 
in the list do not affect the configuration of the product.  
 
Note: This product displays a dialog box stating that not all items can be deleted.  

7. When the deletion is complete, you have removed all information about the product 
from the SAS Metadata Server. 

8. Stop the SAS Management Console 

 

Configuring the Product: 

1. Start the SAS Deployment Wizard. 

2. In the Select Deployment task window, in the 'End-User Tasks' section, select 'Install 
SAS software'. Then click Next. 

3. In the Specify SAS Home window, select 'Select a previously created SAS Home' and 
choose the correct location for that installation. Then click Next. 

4. In the Select Deployment Type window, select 'Perform a Planned Deployment'.  

5. In the Perform a Planned Deployment section select only the 'Configure SAS Software' 
selection. Then click Next. 
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6. In the Specify Deployment Plan window, select 'Specify the full path to a customized 
deployment plan.  

7. In the Specify the full path to a customized deployment plan section navigate to and 
select your plan. Then click Next. 

8. In the Select Deployment Step window, select your 'Deployment Step'. Then click 
Next. 

9. Click Next in the Checking System window.  

10. In the Select Configuration Prompting Level, select the level that is most appropriate 
to the amount of configuration that you would like to perform for this deployment. 
Then click Next. 

11. In the Specify Configuration Information window, change the 'Configuration Directory' 
to the location of the currently configured system.  

12. In the 'Configuration Level' section, select the level of the currently configured 
system. Then click Next. 

13. The SAS Deployment Wizard (on <hostname>) window appears and states that the 
configuration directory and level specified contain existing files. Click the Yes button 
to continue.  

14. In the Select Products to Configure window, select the following Products (12bytes are 
listed in the parenthesis): 

o SAS Visual Process Orchestration Server Configuration (posvrc)  
o SAS Visual Process Orchestration Design Server Configuration (posvrdsgnc)  
o SAS Visual Process Orchestration Mid-Tier (dmpomid)  
o SAS Web Application Server Configuration (vfabrictcsvr)  

  

15. In the Migration Information window, click Next. Do not select the Perform 
Migration option.  

16. Complete the options needed for this product based on the customer's configuration 
and follow the steps through the end of the SAS Deployment Wizard configuration 
process.  

 

Load Content Adjustment:  
These steps can take place only during the configuration of the Visual Process Orchestration 
product configuration phase of the SAS Deployment Wizard. The SAS Web Application 
Server must be running to adjust the entries in the content server to continue. 
 

1. An error dialog box appears when loading content for the Visual Process Orchestration 
Mid-Tier. DO NOT close this dialog box. Continue to the next step. 

2. Type in the following URL in a web browser that has access to the SAS Web 
Application Server: 
http://<hostname>:<port>/SASContentServer/dircontents.jsp 
 
Note: Replace <hostname> and <port> with the system information of the machine 
that you are configuring. Log on with your sasadm account credentials. 
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3. Select the 'Item name' : sascontent and click on that item.  

4. Select the 'Item name' : System and click on that item.  

5. Select the 'Item name' : Applications and click on that item.  

6. Look for the 'Item name' : SASVisualProcessOrchestration DO NOT click on that item.  

7. Select the check box under the button labeled: Delete for 
SASVisualProcessOrchestration  

8. Click the Delete button. This removes that content from the SAS Content Server.  

9. Go back to the dialog box that you left open in Step #1.  

10. Click the Retry button in the SAS Deployment Wizard Configuration window.  

11. Follow the steps through the end of the SAS Deployment Wizard configuration 
process.  

 

Fixing Users Credentials for the Visual Process Orchestration Design Server 
 
These steps are needed to fix the user credentials on your target machine.  
 

1. Log on to the SAS Management Console as the unrestricted user (sasadm@saspw)  

2. Expand the server manager/SASApp/SASApp - Logical Visual Process Orchestration 
Design Server. See whether it validates.  

3. If it does not validate, select SASApp - Visual Process Orchestration Design 
Server with your mouse.  

4. Use the right mouse button to bring up the pop-up menu and select Properties.  

5. In the SASApp - Visual Process Orchestration Design Server Properties window, 
choose the Option' tab.  

6. If Multiuser credential is set to (None), select the drop-down list and choose More 
logins.  

7. In the Select Login window, search for sassrv and select that as the user value.  

8. See whether it validates. If it does not validate, might need to restart the object 
spawner on the server.  
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Data Management Console Mid-Tier 
 
Removing the product from SAS METADATA REPOSITORY: 

1. Start the SAS Management Console (sasadm) 

2. Connect to the system that you want to recover. 

3. Select the Search tab. 

4. In the search field type: Data Management Console 

5. In the result pane, select all items. 

6. Now delete these items. 

7. When the deletion is complete, you have removed all information about the product 
from the SAS Metadata Server. 

8. Stop the SAS Management Console 

 
Configuring the Product: 

1. Start the SAS Deployment Wizard.  

2. In the Select Deployment task window, in the 'End-User Tasks' section, select Install 
SAS software. Then click Next. 

3. In the Specify SAS Home window, select Select a previously created SAS Home 
and choose the correct location for that installation. Then click Next. 

4. In the Select Deployment Type window, select Perform a Planned Deployment. 

5. In the Perform a Planned Deployment section select only the 'Configure SAS Software' 
selection. Then click Next. 

6. In the Specify Deployment Plan window, select 'Specify the full path to a customized 
deployment plan. 

7. In the 'Specify the full path to a customized deployment plan' section navigate to and 
select your plan. Then click Next. 

8. In the Select Deployment Step window, select your Deployment Step. Then click 
Next. 

9. Click Next in the Checking System window. 

10. In the Select Configuration Prompting Level window, select the level that is most 
appropriate to the amount of configuration that you would like to perform for this 
deployment. Then click Next. 

11. In the Specify Configuration Information window, change the Configuration Directory 
to the location of the currently configured system. 
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12. In the Configuration Level section, select the level of the currently configured system. 
Then click Next. 

13. The SAS Deployment Wizard (on <hostname>) window appears and states that the 
configuration directory and level specified contain existing files. Click the Yes button 
to continue. 

14. In the Select Products to Configure window, select the following Products (12bytes are 
listed in the parenthesis): 
 

o SAS Data Management Console Mid-Tier (dmcoremid) 
o SAS Web Application Server Configuration (vfabrictcsvr) 

 

15. In the Migration Information window, click Next. Do NOT select the Perform 
Migration option. 

16. Complete the options needed for this product based on the customer's configuration 
and follow the steps through the end of the SAS Deployment Wizard configuration 
process. 

  

Data Remediation 
 
Removing the Product from SAS Metadata Repository: 

1. Start the SAS Management Console (sasadm) 

2. Connect to the system that you want to recover. 

3. Select the Search tab. 

4. In the search field type: Remediation 

5. In the result pane, select ALL items. 

6. Now delete these items. 

7. When the deletion is complete, you have removed all information about the product 
from SAS Metadata Repository. 

8. Stop the SAS Management Console 

  
Backing Up Database: 
The database admin should back up the Postgres data for Data Remediation on the source 
machine if the data is needed on the target machine. 
 

1. On the Database Server go to this directory: 
SASHome/SASWebInfrastructurePlatformDataServer/9.4/bin 
Note: On a Linux or Unix-based system, you need to set your LD_LIBRARY_PATH to 
include: SASHome/SASWebInfrastructurePlatformDataServer/9.4/lib 
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2. Run this command: 
./pg_dump -c -h <remedation data server host> -p <remediation data server port> -
U rmdbadmin -f dmdsvrc.db.backup DataRemediationDataServer 
Note: Provide the database user password on the command line. 

  
Removing the 'Data Server' Database Storage: 
  

Delete the contents under the config/lev<n>/DataRemediationDataServer directory. 
 
Configuring the Product: 

1. Start the SAS Deployment Wizard. 

2. In the Select Deployment task window, in the 'End-User Tasks' section, select 'Install 
SAS software'. Then click Next. 

3. In the Specify SAS Home window, select 'Select a previously created SAS Home' and 
choose the correct location for that installation. Then click Next. 

4. In the Select Deployment Type window, select 'Perform a Planned Deployment'. 

5. In the 'Perform a Planned Deployment' section select ONLY the 'Configure SAS 
Software' selection. Then click Next. 

6. In the Specify Deployment Plan window, select 'Specify the full path to a customized 
deployment plan. 

7. In the 'Specify the full path to a customized deployment plan' section navigate to and 
select your plan. Then click Next. 

8. In the Select Deployment Step window, select your 'Deployment Step'. Then click 
Next. 

9. Click Next in the Checking System window.  

10. In the 'Select Configuration Prompting Level', select the level that is most appropriate 
to the amount of configuration that you would like to perform for this deployment. 
Then click Next. 

11. In the Specify Configuration Information window, change the 'Configuration Directory' 
to the location of the currently configured system. 

12. In the 'Configuration Level' section, select the level of the currently configured 
system. Then click Next. 

13. The SAS Deployment Wizard (on <hostname>) appears and states that the 
configuration directory and level specified contain existing files. Click the Yes button 
to continue. 

14. In the Select Products to Configure window, select the following Products (12bytes are 
listed in the parenthesis):  

o SAS Data Remediation Mid-Tier (dmrmdtmid) 
o SAS Data Remediation Data Server (dmrmdtdsvrc) 
o SAS Web Application Server Configuration (vfabrictcsvr) 
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15. In the Migration Information window, click Next. Do NOT select the Perform 
Migration option.  

16. Complete the options needed for this product based on the customer's configuration 
and follow the steps through the end of the SAS Deployment Wizard configuration 
process. 

  
Restoring the Database to the Target Host: 

1. On the Database Server go to this 
directory: SASHome/SASWebInfrastructurePlatformDataServer/9.4/bin  
 
Note: On a Linux or Unix-based system, set your LD_LIBRARY_PATH to 
include: SASHome/SASWebInfrastructurePlatformDataServer/9.4/lib  
 

2. Run this command:  

./psql -d DataRemediationDataServer -f dmdsvrc.db.backup -h 
<remediation data server host> -p <remediation data server port> -
U rmdbadmin  
 
Note: This replaces the previous DataRemediationDataServer database. You also 
need to provide the database user password on the command line.  

  

Job Monitor  
  
Removing the Product from SAS Metadata Repository:  

1. Start the SAS Management Console (sasadm)  

2. Connect to the system that you want to recover.  

3. Select the Search tab.  

4. In the search field type: Job Monitor  

5. In the result pane, select ALL items.  

6. Now delete these items.  

7. When the deletion is complete, you have removed all information about the product 
from the SAS Metadata Server.  

8. Stop the SAS Management Console  

  
Removing the 'Data Server' Database Storage:  

Delete the contents under the config/lev<n>/JobMonitorDataServer directory.  
  
Configuring the Product:  

1. Start the SAS Deployment Wizard.  
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2. In the Select Deployment task window, in the 'End-User Tasks' section, select 'Install 
SAS software'. Then click Next.  

3. In the Specify SAS Home window, select 'Select a previously created SAS Home' and 
choose the correct location for that installation. Then click Next.  

4. In the Select Deployment Type window, select 'Perform a Planned Deployment'.  

5. In the 'Perform a Planned Deployment' section select ONLY the 'Configure SAS 
Software' selection. Then click Next.  

6. In the 'Specify Deployment Plan window, select 'Specify the full path to a customized 
deployment plan.  

7. In the 'Specify the full path to a customized deployment plan' section navigate to and 
select your plan. Then click Next.  

8. In the Select Deployment Step window, select your 'Deployment Step'. Then click 
Next.  

9. Click Next in the Checking System window.  

10. In the 'Select Configuration Prompting Level', select the level that is most appropriate 
to the amount of configuration that you would like to perform for this deployment. 
Then click Next.  

11. In the Specify Configuration Information window, change the 'Configuration Directory' 
to the location of the currently configured system.  

12. In the 'Configuration Level' section, select the level of the currently configured 
system. Then click Next.  

13. The SAS Deployment Wizard (on <hostname>) window appears and states that the 
configuration directory and level specified contain existing files. Click the Yes button 
to continue.  

14. In the Select Products to Configure window, select the following Products (12bytes are 
listed in the parenthesis): 

o SAS Job Monitor Mid-Tier Services (jobmntrsvc)  
o SAS Job Monitor Data Server Configuration (jobmntrdsvrc)  
o SAS Job Monitor Administration (jobmntrhyp)  
o SAS Web Application Server Configuration (vfabrictcsvr)  

15. In the Migration Information window, click Next. Do not select the Perform 
Migration option.  

16. Complete the options needed for this product based on the customer's configuration 
and follow the steps through the end of the SAS Deployment Wizard configuration 
process.  
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Task Manager  
  
Removing the Product from SAS Metadata Repository:  

1. Start the SAS Management Console (sasadm)  

2. Connect to the system that you want to recover.  

3. Select the Search tab.  

4. In the search field type: Task Manager  

5. In the result pane, select ALL items.  

6. Now delete these items.  

7. When the deletion is complete, you have removed all information about the product 
from SAS Metadata Repository.  

8. Stop the SAS Management Console  

  
Configuring the Product:  

1. Start the SAS Deployment Wizard.  

2. In the Select Deployment task window, in the 'End-User Tasks' section, select 'Install 
SAS software'. Then click Next.  

3. In the Specify SAS Home window, select 'Select a previously created SAS Home' and 
choose the correct location for that installation. Then click Next.  

4. In the Select Deployment Type window, select 'Perform a Planned Deployment'.  

5. In the ‘Perform a Planned Deployment' section select ONLY the 'Configure SAS 
Software' selection. Then click Next.  

6. In the Specify Deployment Plan window, select 'Specify the full path to a customized 
deployment plan.’  

7. In the 'Specify the full path to a customized deployment plan' section navigate to and 
select your plan. Then click Next.  

8. In the 'Select Deployment Step' window, select your 'Deployment Step'. Then click 
Next.  

9. Click Next in the Checking System window.  

10. In the 'Select Configuration Prompting Level', select the level that is most appropriate 
to the amount of configuration that you would like to perform for this deployment. 
Then click Next.  

11. In the Specify Configuration Information window, change the 'Configuration Directory' 
to the location of the currently configured system.  

12. In the 'Configuration Level' section, select the level of the currently configured 
system. Then click Next. 
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13. The SAS Deployment Wizard (on <hostname>) appears and states that the 
configuration directory and level specified contain existing files. Click the Yes button 
to continue.  

14. In the Select Products to Configure window, select the following Products (12bytes are 
listed in the parenthesis): 

o SAS Task Manager Mid-Tier (dmtskbxmid)  
o SAS Web Application Server Configuration (vfabrictcsvr)  

15. In the Migration Information window, click Next. Do NOT select the Perform 
Migration option.  

16. Complete the options needed for this product based on the customer's configuration 
and follow the steps through the end of the SAS Deployment Wizard configuration 
process.  
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Chapter 7: Quality Knowledge 
Base Migration 
There is no way to use an equivalent DataFlux dfPower Studio version 8.1 QKB engine in 
DataFlux Data Management Studio v. 2.2. The closest offered is the dfPower v. 8.2 engine. 
dfPower v. 8.1 and v. 8.2 QKB engines were deemed compatible as well as v. 8.2 and 2.2. 
However, this does not mean that for one set of specific data that a match code generated 
in v. 8.2 matches what was generated in v. 2.2. It is recommended that you use the default 
setting of v. 2.2 for the QKB engine. However, if this is not acceptable, you can set DataFlux 
Data Management Studio to use the v. 8.2 QKB engine by adding the following to the 
app.cfg file: 

QKB/COMPATVER = dfpower82 
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Appendix 1: Technical Support 
This section addresses questions and issues related to migrating DataFlux products. 

Troubleshooting 
DataFlux dfPower Real-time Service Issues 
Issue: You see this Run Job error message: 

The server was unable to run the job; the error message was "Failed To Set 
Job Input". 

Cause: You are trying to run an Architect Job that contains macros. 

Resolution: Add this configuration setting to the service.cfg file: 

DATASVC/IGNORE_DECLARED_VARS = yes 
 

 

Issue: The DataFlux Data Management Server v. 2.2 log shows this message: 

Failed to set input key '<macro variable>'; err: Process Flow - Variable 
'<macro variable>' was not declared, or is of the wrong type. 

Where <macro variable> is the name of the macro that you tried to pass values into. 

Cause: You upgraded a job with macros, but the job is missing input/output variables 
required for DataFlux Data Management style jobs. 

Resolution: Add this configuration setting to the service.cfg file: 

DATASVC/IGNORE_DECLARED_VARS = yes 
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Appendix 2: Legal Notices 
Apache Portable Runtime License Disclosure 

Copyright © 2008 DataFlux Corporation LLC, Cary, NC USA.  

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance 
with the License. You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0  

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on 
an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the 
License for the specific language governing permissions and limitations under the License. 

Apache/Xerces Copyright Disclosure 

The Apache Software License, Version 3.1 

Copyright © 1999-2003 The Apache Software Foundation.  All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met: 

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

3. The end-user documentation included with the redistribution, if any, must include the following 
acknowledgment: 
 
"This product includes software developed by the Apache Software Foundation (http://www.apache.org)." 
 
Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party 
acknowledgments normally appear. 

4. The names "Xerces" and "Apache Software Foundation" must not be used to endorse or promote products 
derived from this software without prior written permission. For written permission, please contact 
apache@apache.org. 

5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, 
without prior written permission of the Apache Software Foundation. 

THIS SOFTWARE IS PROVIDED "AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED.  IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE 
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

This software consists of voluntary contributions made by many individuals on behalf of the Apache Software 
Foundation and was originally based on software copyright (c) 1999, International Business Machines, Inc., 
http://www.ibm.com.  For more information on the Apache Software Foundation, please see 
http://www.apache.org. 
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Boost Software License Disclosure 

Boost Software License - Version 1.0 - August 17, 2003 

Permission is hereby granted, free of charge, to any person or organization obtaining a copy of the software and 
accompanying documentation covered by this license (the "Software") to use, reproduce, display, distribute, 
execute, and transmit the Software, and to prepare derivative works of the Software, and to permit third-parties to 
whom the Software is furnished to do so, all subject to the following: 

The copyright notices in the Software and this entire statement, including the above license grant, this restriction 
and the following disclaimer, must be included in all copies of the Software, in whole or in part, and all derivative 
works of the Software, unless such copies or derivative works are solely in the form of machine-executable object 
code generated by a source language processor. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE 
AND NON-INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE 
SOFTWARE BE LIABLE FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE. 

Canada Post Copyright Disclosure 

The Data for areas of Canada includes information taken with permission from Canadian authorities, including: © 
Her Majesty the Queen in Right of Canada, © Queen's Printer for Ontario, © Canada Post Corporation, GeoBase®, 
© Department of Natural Resources Canada. All rights reserved. 

DataDirect Copyright Disclosure 

Portions of this software are copyrighted by DataDirect Technologies Corp., 1991 - 2008. 

Expat Copyright Disclosure 

Part of the software embedded in this product is Expat software. 

Copyright © 1998, 1999, 2000 Thai Open Source Software Center Ltd. 

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the 
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit 
persons to whom the Software is furnished to do so, subject to the following conditions: 

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the 
Software. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, 
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, 
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.  

gSOAP Copyright Disclosure 

Part of the software embedded in this product is gSOAP software. 

Portions created by gSOAP are Copyright © 2001-2004 Robert A. van Engelen, Genivia inc. All Rights Reserved. 

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE 
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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IBM Copyright Disclosure 

ICU License - ICU 1.8.1 and later [as used in DataFlux clients and servers.] 

COPYRIGHT AND PERMISSION NOTICE 

Copyright © 1995-2005 International Business Machines Corporation and others. All Rights Reserved. 

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the 
rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to 
whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice 
appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear 
in supporting documentation. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS 
INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL 
DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN 
ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH 
THE USE OR PERFORMANCE OF THIS SOFTWARE. 

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to 
promote the sale, use or other dealings in this Software without prior written authorization of the copyright holder. 

Informatica Address Doctor Copyright Disclosure 

AddressDoctor® Software, © 1994-2015 Platon Data Technology GmbH 

Loqate Copyright Disclosure 

The Customer hereby acknowledges the following Copyright notices may apply to reference data. 

Australia: Copyright. Based on data provided under license from PSMA Australia Limited (www.psma.com.au) 

Austria: © Bundesamt für Eich- und Vermessungswesen 

Brazil: Conteudo firnecido por MapLink. Brazil POIs may not be used in publicly accessible, internet-based web sites 
whereby consumers obtain POI data for their personal use. 

Canada: 

Copyright Notice: This data includes information taken with permission from Canadian authorities, including © Her 
Majesty, © Queen’s Printer for Ontario, © Canada Post, GeoBase ®. 

End User Terms: The Data may include or reflect data of licensors including Her Majesty and Canada Post. Such 
data is licensed on an “as is” basis. The licensors, including Her Majesty and Canada Post, make no guarantees, 
representation, or warranties respecting such data, either express or implied, arising by law or otherwise, including 
but not limited to, effectiveness, completeness, accuracy, or fitness for a purpose. 

The licensors, including Her Majesty and Canada Post, shall not be liable in respect of any claim, demand or action, 
irrespective of the nature of the cause of the claim, demand or action alleging any loss, injury or damages, direct 
or indirect, which may result from the use or possession of the data or the Data. The licensors, including Her 
Majesty and Canada Post, shall not be liable in any way for loss of revenues or contracts, or any other 
consequential loss of any kind resulting from any defect in the data or in the Data. 

End User shall indemnify and save harmless the licensors, including Her Majesty the Queen, the Minister of Natural 
Resources of Canada and Canada Post, and their officers, employees and agents from and against any claim, 
demand or action, irrespective of the nature of the cause of the claim, demand or action, alleging loss, costs, 
expenses, damages, or injuries (including injuries resulting in death) arising out of the use of possession of the 
data or the Data. 

Croatia, Cyprus, Estonia, Latvia, Lithuania, Moldova, Poland, Slovenia, and/or Ukraine: © EuroGeographics 

France: source: Géoroute® IGN France & BD Carto® IGN France 

Germany: Die Grundlagendaten wurden mit Genehmigung der zuständigen Behörden entnommen 

Great Britain: Based upon Crown Copyright material. 

http://www.psma.com.au/
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Greece: Copyright Geomatics Ltd. 

Hungary: Copyright © 2003; Top-Map Ltd. 

Italy: La Banca Dati Italiana è stata prodotta usando quale riferimento anche cartografia numerica ed al tratto 
prodotta e fornita dalla Regione Toscana. 

Norway: Copyright © 2000; Norwegian Mapping Authority 

Portugal: Source: IgeoE – Portugal 

Spain: Información geográfica propiedad del CNIG 

Sweden: Based upon electronic data © National Land Survey Sweden. 

Switzerland: Topografische Grundlage © Bundesamt für Landestopographie. 

Microsoft Copyright Disclosure 

Microsoft®, Windows, NT, SQL Server, and Access, are either registered trademarks or trademarks of Microsoft 
Corporation in the United States and/or other countries. 

Oracle Copyright Disclosure 

Oracle, JD Edwards, PeopleSoft, and Siebel are registered trademarks of Oracle Corporation and/or its affiliates. 

PCRE Copyright Disclosure 

A modified version of the open source software PCRE library package, written by Philip Hazel and copyrighted by 
the University of Cambridge, England, has been used by DataFlux for regular expression support. More information 
on this library can be found at: ftp://ftp.csx.cam.ac.uk/pub/software/programming/pcre/. 

Copyright © 1997-2005 University of Cambridge. All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met: 

• Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

• Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

• Neither the name of the University of Cambridge nor the name of Google Inc. nor the names of their 
contributors may be used to endorse or promote products derived from this software without specific prior 
written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF 
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

Red Hat Copyright Disclosure 

Red Hat® Enterprise Linux®, and Red Hat Fedora™ are registered trademarks of Red Hat, Inc. in the United States 
and other countries. 

SAS Copyright Disclosure 

Portions of this software and documentation are copyrighted by SAS® Institute Inc., Cary, NC, USA, 2009. All 
Rights Reserved. 
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SQLite Copyright Disclosure 

The original author of SQLite has dedicated the code to the public domain. Anyone is free to copy, modify, publish, 
use, compile, sell, or distribute the original SQLite code, either in source code form or as a compiled binary, for any 
purpose, commercial or non-commercial, and by any means. 

Sun Microsystems Copyright Disclosure 

Java™ is a trademark of Sun Microsystems, Inc. in the U.S. or other countries. 

TomTom Copyright Disclosure  

© 2006-2015 TomTom. All rights reserved. This material is proprietary and the subject of copyright protection, 
database right protection, and other intellectual property rights owned by TomTom or its suppliers. The use of this 
material is subject to the terms of a license agreement. Any unauthorized copying or disclosure of this material will 
lead to criminal and civil liabilities. 

USPS Copyright Disclosure 

National ZIP®, ZIP+4®, Delivery Point Barcode Information, DPV, RDI, and NCOALink®. © United States Postal 
Service 2005. ZIP Code® and ZIP+4® are registered trademarks of the U.S. Postal Service. 

DataFlux is a non-exclusive interface distributor of the United States Postal Service and holds a non-exclusive 
license from the United States Postal Service to publish and sell USPS CASS, DPV, and RDI information. This 
information is confidential and proprietary to the United States Postal Service. The price of these products is 
neither established, controlled, or approved by the United States Postal Service. 

VMware Copyright Disclosure 

 VMware® virtual environment provided those products faithfully replicate the native hardware and provided the 
native hardware is one supported in the applicable DataFlux product documentation. All DataFlux technical support 
is provided under the terms of a written license agreement signed by the DataFlux customer. 

The VMware virtual environment may affect certain functions in DataFlux products (for example, sizing and 
recommendations), and it may not be possible to fix all problems. 

If DataFlux believes the virtualization layer is the root cause of an incident; the customer will be directed to contact 
the appropriate VMware support provider to resolve the VMware issue and DataFlux shall have no further obligation 
for the issue. 
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